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INTRODUCTION

The following major topics are discussed in this chapter:

“About this Guide” on page 1

“nView Components: Display Properties and Desktop Manager” on page 2
“Why Do I Need Desktop Management?” on page 3

“About nView Desktop Manager” on page 4

“Key Terms and Concepts” on page 8

“Features and Benefits” on page 11

“Application Compatibility” on page 18

“Notes on Feature and Configuration Support” on page 19

“Examples in this Guide” on page 21

About this Guide

This is a user’s guide addressed to end users of the NVIDIA® nView™ Desktop
Manager application, which is a component of the NVIDIA ForceWare™
graphics drivers. nView Desktop Manager is a desktop and application
management tool that runs on Microsoft® Windows® operating systems and
graphics cards based on NVIDIA graphics processing units (GPUs).

Note: Supported NVIDIA GPUs are listed in Table 2.5. For technical details on

the features and benefits of the NVIDIA ForceWare graphics driver, refer
to the NVIDIA Web page: www.nvidia.com.
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Other Related Documentation

» Ifyou are primarily using the display properties components of the NVIDIA
ForceWare graphics drivers with NVIDIA GeForce™-based GPUs, see the
following user’s guide:

NVIDIA ForceWare Graphics Drivers User’s Guide

» Ifyou are primarily using the display properties components of the NVIDIA
ForceWare graphics drivers with NVIDIA Quadro®-based GPUs, see the
following user’s guide:

ForceWare Graphics Drivers: Quadro Workstation User’s Guide

* The documents titled NVIDIA Drivers for Windows: Release 50 Notes
describe performance improvements and bug fixes in the ForceWare graphics
drivers. These documents enable add-in-card (AIC) producers and original
equipment manufacturers (OEMs) to monitor performance improvements
and bug fixes in the driver.

nView Components: Display Properties and Desktop
Manager

The NVIDIA ForceWare graphics driver software includes two user interface-
based components: nView display properties and nView Desktop Manager.

* nView represents a collection of multi-display technologies encompassing
driver support, multi-display GPU architecture, and desktop management
support.

» Display properties refers to the NVIDIA Windows Control Panel-based user
interface, which you can access from the Windows Display Properties >
Settings > Advanced option. Once you click the NVIDIA GPU tab name, a
menu appears from which you can configure the advanced display properties
of the current release of the NVIDIA ForceWare graphics driver software.

* The primary nView component is the Desktop Manager (the topic of this
user’s guide), which is a user level application utility that focuses on making
you more productive when working on your Windows desktop. Desktop
Manager was originally created for multi-display graphics cards but has
grown to enhance single-display user desktops as well. Desktop Manager
supports both single-display and multidisplay configurations running with
single-display, multi-display, or multiple graphics cards based on NVIDIA
GPUs.
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As with the display properties component, now you can also access the
nView Desktop Manager control panel and configure its features from the
Windows Display Properties > Settings > Advanced option.

Desktop Manager is also a separate item on the Windows Control Panel
group (Figure 1.1). You can click this item to access the nView Desktop
Manager control panel. There are several additional ways to enable the
nView Desktop Manager control panel to configure its various features. For
complete details, see “Accessing and Enabling the nView Desktop Manager
Control Panel” on page 59.

Figure 1.1 Windows Control Panel with nView Desktop Manager Item
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Why Do | Need Desktop Management?

As users run more and more applications and process even more information,
their screen sizes are getting larger and larger. Larger screen area simply makes
users more productive.

One of the more cost effective and common ways of increasing screen area is to
use multiple displays and/or multiple desktops (for single-display users), which
allow you to place your applications on multiple displays having ready and
immediate access to the information they contain.

While large screens and multiple displays and desktops are a great way of
increasing your visible work area, these larger desktops start becoming more
difficult to manage. Once simple operations such as finding your mouse cursor
or even a window can become very time-consuming when you have to hunt
through several screens.

In addition, using multiple displays results in additional issues such as the
screen split between two displays — windows that are placed on this screen split
are extremely difficult to read. So, while larger desktop areas promise to
dramatically increase your productivity, there are user interface issues that can
make it difficult to use at times.
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A “desktop manager” manages your large desktop and takes care of many of the
user interface issues that result from moving to a larger desktop area. You can
think of a desktop manager as being an extension of the windows user interface
tailored for large desktops.

About nView Desktop Manager

nView Desktop Manager supports both single-display and multi-display
configurations running with single-display, multi-display, or multiple graphics
cards based on NVIDIA GPUs.

Multi-Display Support

The nView Desktop Manager feature set primarily focuses on multi-display use
by workstation users in finance, corporate, digital content creation (DCC) and
similar organizations as well as in the mobile (laptop) markets. Therefore, to
take advantage of the full feature set of the Desktop Manager, you need a multi-
display configuration. With multiple displays, you can view a single application
as a large window stretching across several displays, or you can display
different applications on each monitor. Using a multi-display configuration is an
efficient and cost-effective way to increase the size of your computer display
area, commonly called the “desktop”.

Single-Display Support

nView Desktop Manager is designed for broad applications across the wide
range of NVIDIA product lines and markets. Therefore, single-display users can
also take advantage of many of its features. Although you cannot use multi-
display features in a single-display configuration, you can create multiple
desktops and use hot keys, NVKeystone, and windows effects.

Release 50: Access Options for the nView Desktop
Manager Control Panel

Note: Starting from this current release (Release 50) of the ForceWare graphics
drivers, all nView Desktop Manager features accessible from the nView
Desktop Manager control panel are also accessible from the NVIDIA
display properties menu, shown in Figure 1.2.

In the previous Release 40 NVIDIA graphics drivers, the nView Desktop
Manager control panel was a standalone user interface with feature-specific tabs
to access a variety of configurable Desktop Manager options.
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In the current Release 50 NVIDIA graphics driver, the nView Desktop Manager
control panel can be opened as a standalone user interface and accessed from
the NVIDIA display properties menu because the Desktop Manager control
panel options have also been integrated into the NVIDIA display properties
control panel menu (Figure 1.2).

Once nView Desktop Manager is enabled, its control panel is easily accessible
from a variety of areas on your desktop, as explained in “Accessing and
Enabling the nView Desktop Manager Control Panel” on page 59, For example,
it is available from:

» the Windows Control Panel group

* the desktop (right click) properties menu

+ the NVIDIA Settings taskbar icon

+ the NVIDIA display properties control panel menu

When you first open the nView Desktop Manager control panel, the default
Desktop Management tab is displayed. Once you enable the Enable nView
Desktop Manager option, the remaining tabs (or menu items) are available and
configurable, as described in “Features and Benefits” on page 11.

Note: Individual chapters in this guide describe the various categories of
features to configure.

Release 50: New Features and Support

¢ nView toolbar lets you dock hot keys and other actions — such as desktop
switching, mode switching, and profile loading — on a toolbar for easy
access.

* Profiles can store and load the open application state.

¢ Kinematic mouse actions such as switching to the next or previous desktop
can be accomplished by specific mouse movements such as shakes or
circular motions. Mouse features also include throw-action detection for a
more interactive “movie style” user interface.

* Resolution per desktop support allows each desktop can be set to a
different resolution.

* Microsoft® Internet Explorer pop-up prevention

* Monitor grids allows display devices to be divided into subgrids, which—
for the purposes of geometric operations such as application window
maximizing—act as separate display devices.

* NVKeystone™ luma compensation
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Figure 1.2 nView Desktop Manager Properties: Tabbed Control Panel vs. Menu Style
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* Application display exclusions and inclusions allows the user to set up
applications to always launch on a specified monitor, or never launch on a

specified monitor.

NVIDIA Corporation



NVIDIA nView Desktop Manager User’s Guide

Release 50: Performance Improvements and
Enhancements

* Desktop switching speed has increased by 40%.

* Integrated control panels -- The nView Desktop Manager control panel is
now consolidated with the NVIDIA display properties control panel.

¢ New nView Desktop Manager Setup Wizard includes mode set support for
nView Standard, Clone, Spanning, and Dualview modes.

* Driver independence allows nView to be installed independently of the
graphics drivers, with no version interdependencies.

Release 40: Features and Enhancements

Feature Enhancements
The following features have been enhanced in the previous Release 40 NVIDIA
nView Desktop Manager:

* Operating System Support includes Windows NT 4.0, Windows 9x/Me,
and Windows 2000/XP.

* Profile feature. Display modes are now saved to and loaded from each
profile.

e Multiple desktop support contains the following new features:

Support for multi-display wallpaper selection. (See “Properties: Changing
Wallpaper and Desktop Icons” on page 90.)

Graphical display in Windows Explorer shell extension

Support for icons to represent desktops. (“Properties: Changing Wallpaper
and Desktop Icons” on page 90.)

Support for arbitrary positioning of windows on the desktops
e Zoom support includes:
New fixed-frame zoom (See “Fixed Frame” on page 139.)

Bi-directional zoom editing capability (See “Enabling Bi-Directional
Editing” on page 140.)

New Features

The following are features that have been added to the new version of NVIDIA
nView Desktop Manager:
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¢ nView Task Switcher. When enabled, nView adds a desktop switcher in
addition to the standard application tab switcher. By default, this additional
“switch desktop” functionality is accessed through a Alt-~ keystroke
combination which you can change through options in the Hot Key panel.
See “Enable nView Task Switcher” on page 106.

* Color-keyed windows allows the user to color key windows for easy
identification when activating them on the desktop. See “Enable Windows
Color Keying” on page 132.

* NVKeystone™ allows real-time image correction on portable projectors and
heads-up displays. (NVKeystone is not supported on graphics cards based on
the TNT, TNT2 or Vanta product families.)

For example, NVKeystone can be set to compensate for keystoning effects
on your windows display, allowing you to fix distorted projection images.
This feature is primarily for laptop (mobile) computers.

See “Accessing NVKeystone” on page 168.
» Taskbar and Menu Transparency. See “Using Effects” on page 129.
* New window actions, such as, Collapse

+ New applications settings, including a full set of application launch and
disable settings. See “Managing Applications: For Advanced Users” on
page 172.

Key Terms and Concepts

Desktop Manager can manage and control many items on your desktop.
Generally, it operates on two types of desktop objects — “windows” or
“applications”.

application

An application (or program) can have any number of windows. Some
applications have only a single window such as Calculator or Notepad. Other
applications can have many windows such as Outlook where you can open
several E-mail windows, have your Inbox open, open calendars, etc.

Desktop Manager can perform operations on applications as well as windows.
In the case of applications, the operation is performed on every window that is
part of that application only if the operation is enabled through the Individual
Settings feature of that application.

If you run multiple copies of an application, any operation you perform on a
copy of the application will apply to every copy of the application that is
running.
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child window

A child window refers to any “sub” window of the main or “parent” application
window. For example, in the Microsoft Excel application, you can open several
worksheets at once inside the main Excel window. Each worksheet is a child
window of Excel.

Control Panel

Refers to the Windows Control Panel group, which you can access by clicking
Start > Settings > Control Panel from the Windows desktop. NVIDIA nView
Desktop Manager is a clickable icon in this group of icons. When you click
this icon, the nView Desktop Manager properties panel (shown in Figure 1.2)
appears.

Note: The nView Desktop Manager properties panel in earlier revisions of the
this document was called the nView Desktop Manager control panel.

desktop

A “desktop” is the on-screen work area on which windows, icons, menus, and
dialog boxes appear. You can create multiple desktops on single-display
systems or multi-display systems, thereby increasing your work area.

dialog box

Dialog boxes are user-input windows that contain command (buttons) and
various kinds of options through which you can carry out a particular command
or task. For example, in a Windows application “Save As” dialog box, you must
indicate the folder to contain the document to be saved and the name of that
document when saving it.

Also see the definition of “modal dialog box” and “modeless dialog box” on this
page.

dual-card configuration

A setup where two or more display devices are connected to two NVIDIA GPU-
based graphics cards installed in the computer.

GPU

graphics processing unit (GPU). NVIDIA graphics chip products are called
GPUs. Supported NVIDIA GPUs are listed in “Supported NVIDIA GPUs” on
page 27.

keystoning (NVKeystone)

Keystoning describes the distortion that occurs when your display is projected
onto a curved surface or is projected at an oblique angle to a surface.
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For example, if a projector were used to project an image on a flat wall, the
projector would ideally be set up to point straight at the wall. If you then angled
the projector right or left, you would see the image on the wall distort.

As a second example, if you projected your image onto a curved wall instead of
a flat wall, you would also see your image distorted. This type of distortion is
called “keystoning.”

The nView Desktop Manager feature called NVKeystone that can compensate
for this effect. For details on using this feature, see “Using Tools Options” on
page 166.

modal dialog box

A dialog box that puts you in the state or “mode” of being able to work only in
the dialog box. You cannot make a modal dialog box inactive. It can only be
closed by clicking one of its buttons.

modeless dialog box

A dialog box that resembles a document window without a collapse box. You
can make a modeless dialog box inactive and active again without closing it.

multiple-card configuration

A setup where two or more display devices are connected to two (or more)
NVIDIA GPU-based graphics cards in the computer.

multi-display configuration
A setup where two or more display devices are connected to either a multi-

display NVIDIA GPU-based graphics card in the computer; or two (or more)
NVIDIA GPU-based graphics cards in the computer.

parent window

A “parent” window refers to the “main” default launch window that you see
when an application opens. For example, in the Microsoft Outlook application,
the main window is your “Inbox”, since that’s the first window that launches
when you open Outlook.

properties panel

NVIDIA nView Desktop Manager is a clickable icon in the Windows Control
Panel group of icons. When you click this icon, the nView Desktop Manager
properties panel (shown in Figure 1.2) appears.

Note: The nView Desktop Manager properties panel in earlier revisions of the
this document was called the nView Desktop Manager control panel.
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single-display configuration
A setup where only one display device is connected to the NVIDIA GPU-based
graphics card in your computer.

skin
A file that customizes the “look and feel” of the Windows graphical user
interface.

tab
Individual Desktop Manager “tabs” (i.e., Profiles, Effects, Windows, Hot Keys,
and Desktops) are available from the nView Desktop Manager properties panel.

window

A “window” is any independent window on your desktop. Applications such as
Outlook or Explorer may have several windows, which are all part of the same
application. Windows can be dragged around the screen, opened and closed, and
resized. Desktop Manager allows you to do even more with windows such as
make them transparent or force them always to be on top of other windows.

window class
(For advanced users only.)

Every type of window shown on your desktop has what is called a “window
class” that describes the type of window it is. These window classes are shared
between different applications. Normally, this window class information is
hidden from users as there is no need to know it. nView Desktop Manager,
however, allows you to perform operations on window classes as well as
applications. This allows nView Desktop Manager to be set up to treat certain
types or classes of windows differently. Because window classes are shared
between applications, by individually configuring a particular window class,
you can modify behavior for all applications that use windows of that class.

For example, all dialog boxes have a window class of #32770. nView Desktop
Manager can be set up to disable transparency for all #32770 class windows.
The effect of this would be that no dialog boxes from any application would
ever be transparent.

For details on using this feature, see “Managing Applications: For Advanced
Users” on page 172.

Features and Benefits

The Desktop Manager application engine consists of several features that
manage windows, desktops, displays, applications, hot keys, and window
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effects. This section provides an overview of the key functions in terms of these
features.

For details on these features and how to use them, refer to individual chapters in
this guide.

Note: A few features may be restricted to users with System Administrator
access privileges under Windows XP/2000 and Windows NT 4 and will
be noted as such, where applicable in this guide.

Desktop Management Panel

When you first launch nView Desktop Manager, the Desktop Management
panel appears. It provides the following information and features:

* nView Desktop Manager file name, description, and version information
+ Lets you toggle between enabling and disabling nView Desktop Manager
* Gives you quick access to the Desktop Manager Setup Wizard

* Gives you quick access to the Windows Display Properties Settings panel

Windows Management

The windows management features are available on the Windows panel of
nView Desktop Manager properties.

Multi-display features allow you to:

* Configure your system to prevent windows from stretching across (spanning)
displays

* Configure where dialog boxes pop up on your desktop. You can have them
appear centered on the display device on which your cursor is displayed

* and much more...

For complete details on using Windows Management features, see “Managing
Windows” on page 79.

About the Desktops Panel

Using the Desktops panel of nView Desktop Manager properties, you can

* Create up to 32 different desktops, each with its own background. Use
multiple desktops to reduce the clutter on your desktop — you can group
similar applications on different desktops and quickly switch between them.

NVIDIA Corporation



NVIDIA nView Desktop Manager User’s Guide

* Open and move applications between different desktops and switch between
desktops with a single keystroke

* Configure multiple-desktop options, including:
Set per desktop resolutions
Show the desktop name while switching desktops

Show your desktops, including a graphical birds-eye view of each desktop
within Windows Explorer

and more. . .

* Manage your desktop in several ways to suite your style. You can access and,
therefore, switch between desktops using various methods, including:

Use hot keys

Right click on any desktop

Your folder tree in Windows Explorer

Options from an NVIDIA Settings icon on your Windows taskbar

A desktop toolbar (enabled from the User Interface panel) that can be
floating or docked to your Windows taskbar

nView task switcher (enabled from the User Interface panel)

For complete details on using Desktops Management features, see “Managing
Desktops” on page 84.

Application Management

The application management functionality of nView Desktop Manager is
available from the Applications panel. You can use the options on the
Applications panel to do the following tasks:

* Perform operations on entire applications, such as moving an entire
application to a desktop or to a monitor.

* Set up your Window Manager to function differently for different
applications. For example, you may never want a Word window to span
multiple displays; however, you may want a spreadsheet, such as Excel
windows, to span multiple displays so you can see all the columns.

+ Save all your customized Desktop Manager settings for an application when
you close it and restore them when you reopen the application.

For example, if you enable the Individual Settings feature, the application
manager can remember if you closed the Microsoft Word application on your
second desktop and whether or not the Word window was transparent when
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you closed it. When you re-open Word, it automatically opens on your
second desktop and have transparency enabled.

Using this feature, you can also specify that Word always launches on a
specific desktop with a specific state (such as Transparent or Always on

top).

+ Extend certain applications. While every window under Desktop Manager
has an extended menu giving options such as transparency or desktop
visibility, certain applications such as Internet Explorer 5.0 have additional
nView menu options allowing you to be more productive with the
application.

About the Profiles Panel

You can quickly set up the Desktop Manager using the Profiles panel on nView
Desktop Manager properties.

Desktop Manager lets you save a snapshot of a// desktop management settings
to the disk, including all individual application, NVKeystone, and other
settings to a data file called a “profile”. In addition, profiles can save and
restore display mode, system power profile, and Windows taskbar location.
Display mode information includes the number and position of enabled display
device, each display device’s refresh rate, resolution, color depth, etc. For
details, see Types of Data Saved and Restored by a Profile below.

Note: Beginning with the current NVIDIA Release 50 driver, profiles can also
save and load the open application states under NVIDIA Quadro-
series GPUs only.

You can then reload your profile on any computer at any point in the future. If
you switch computers, upgrade your operating system, or are configuring an
office, you can simply save all your settings to a profile and then load those
settings on any computer that you want.

Note: If you are using an NVIDIA Quadro-based graphics card, the nView
Desktop Manager installation comes with several pre-defined profiles to
get you started quickly. These profiles contain the basic settings for
different user levels and industries. You can start with one of these pre-
defined profiles and tailor it to your own needs.

Types of Data Saved and Restored by a Profile

Specific types of NVIDIA graphics driver and display mode settings that can be
saved in a profile are:

¢ Graphics Driver Settings

Desktop colors
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Performance and quality settings, including OpenGL and Direct3D
Overlap and edge blending settings (applies to Quadro FX series of GPUs)

Overlay and full screen video settings

Desktop Management Settings include:

Open application state

Desktop Management
* Display mode information
Taskbar position

Computer power state

Saving Profiles for Different Operating Modes

If you use a notebook (laptop) computer, you may want Desktop Manager to be
set up differently when you are docked than when you are not docked. Using
profiles, you can create a docked and undocked profile and switch between
them. You can even set up a hot key to load a profile so you can switch with a
single keystroke.

Profiles management features are discussed in “Working With Profiles” on
page 70

About the User Interface Panel

The nView Desktop Manager User Interface options let you customize the user
interface that is used on your desktop. Using the User Interface features, you
can do the following:

* Control nView Desktop Manager access and notification messages
» Switch between desktops
* Dock profiles, actions, and desktops on an nView toolbar

* Define gridlines on each of your monitors, which divides your display area o
function as sub-monitors for easily performing tasks involving dialog box
repositioning, window spanning and window maximize operations, etc.

* Add application title bar buttons that give you quick and easy access to
nView features and also provide feedback about the application state.

For example, the application title bar “maximize” button maximizes an
application window to full desktop in Dualview, Clone, and Single-Display
mode or a single display screen in nView Horizontal or Vertical Span mode.
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* The nView options menu on each application window let you access nView
options (features), which can also be customized for individual applications.

The User Interface features are discussed in “Using the User Interface Options”
on page 104.

About the Tools Panel

For details on using the Tools features, see “Using Tools Options” on page 166.

The nView Desktop Manager toolbox includes several utilities designed to
solve specific user problems. You can use tools, such as “NVKeystone” and
“flat panel calibration” to improve your display quality. Utilities include anti-
keystoning support and flat panel monitor calibration screens are designed to
improve windows multi-display features.

The Tools panel contains the following key features:

* NVKeystone can be set to compensate for keystoning effects on your
windows display, allowing you to fix distorted projection images. This
feature is primarily for laptop (mobile) computers.

* Analog flat panel calibration displays a screen on your display optimized
for your flat panel’s auto-calibrate feature allowing for improved image
quality during the “auto-sync” process.

* Automatically align displays will snap multiple displays into alignment if
they are slightly misaligned. This also fixes certain Windows issues where
Windows can sometimes leave small gaps between displays.

About the Zoom Panel

The Zoom panel shows you a user-definable zoom area of your desktop. Basic
Zoom styles include

Cursor — window shows area around cursor.

Magnifying Glass — you can drag the zoom window around to zoom the
area of the desktop on which you place the zoom window.

Fixed Frame — lets you define a fixed zoom source for the window.
Other zoom features include:
+ Using the mouse wheel to dynamically change zoom levels
+ Using the auto-move feature to keep the zoom window out of your way.
+ Using bi-directional zoom editing to edit through your zoom window.

* Inverting colors of the zoomed image for better visibility.
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For additional details,

About the Hot Keys and Effects Panels

The Effects and Hot Key panel options offer additional enhancements,
including:

Faster opening and closing of windows

Making windows transparent when dragged and making the taskbar
transparent

Note: The transparency level is a global level affecting all applications. Note
that this value is one which can be individualized for an application

A “zoom” tool that lets you see a zoomed view of the area around the cursor.
You can even use the zoom tool like a magnifying glass and drop it on top of
what you want to magnify on the desktop

A full set of hot keys. Virtually every action from toggling a window to be
transparent to jumping to a different desktop can be assigned to a hot key.

For NVIDIA Quadro-based cards, the color keying feature allows you to
color windows with different borders, which is most useful with individual
application settings and hot keys

For details on using the above features, see the following chapters, as
appropriate:

“Using Zoom Options” on page 136
“Using Effects” on page 129
“Using Hot Keys” on page 150.

About the Mouse Panel

The Mouse panel of the nView Desktop Manager properties lets you configure
a variety of mouse-related actions for easier navigation.

A few key features are described here:

The throw window action allows you the “throw” a window to a screen
edge using your mouse.

Throw Sensitivity can be adjusted using a slider

The Jump dead screen areas option will cause the mouse to jump dead
areas in non-rectangular multi-display configurations as long as you are
moving your mouse at a reasonable speed.
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* Toggle window Z-order with middle mouse button option does the same
as the hot key only with the mouse and to the window that contains the
Ccursor.

* Auto-activate windows under cursor — does just that
+ Kinematics and gestures features allow you to

Assign mouse movements to trigger different actions (same actions as hot
keys)

Adjust the gestures with a Gesture Sensitivity slider

Use a key press to control these actions

Setup Wizard and Online Help

* A Setup Wizard helps you get started with Desktop Manager.

* On-line Help displays context-sensitive help when using Desktop Manager
configuration options.

Application Compatibility

18

While the vast majority of applications are compatible with desktop and
windows management, there are some applications that are not. If Desktop
Manager detects these types of applications, it will not attempt to manage them.
Depending upon the level of compatibility of the application, Desktop Manager
may offer varying levels of functionality.

Functionality that may be disabled for these applications includes support for
Transparency and Individual Settings features, window position management,
nView Desktop Manger menu options, and/or multiple desktop support.

If an application window supports the nView Options Menu, but does not
support certain Desktop Manager functions, a menu item called About this
app... is added to the application’s nView option menu. In this case, you can
click on this menu item to display information about the features that have been
disabled for the application.

If you have any nView title bar buttons enabled, then an nView application
status indicator appears to the left of the nView buttons. If the application does
not support certain nView functions, this indicator will be red; otherwise it will
be black. If the indicator is red, you can click it to display information about the
features that have been disabled for this application. For further details, see
“Using the User Interface Options” on page 104.
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Applications Incompatible with Certain Features

Examples of application windows that do not support certain Desktop Manager
features include:

* Command prompt (DOS window) under all operating systems. (All
desktop management features are disabled.)

* Solitaire and Freecell under Windows Me. (All window management
features are disabled.)

* Microsoft PowerPoint®--- The transparency feature is disabled.

Skinning Utilities: Known Issues

If you use skins, Desktop Manager has been tested with several commonly
available “skinning” utilities with no known compatibility issues other than
those listed below.

Some skins do not expose the application window’s system menu on its window
frame (title bar). As a result, the nView options menu can only be accessed from
either a title bar button (see “Show Button for nView Options” on page 116) or
a hot key but not from the application window’s system menu.

However, you can still access the nView options menu by right clicking the
application on the taskbar. For details on the methods available for accessing an
application’s system menu, see “Add nView Options to System Menus” on
page 121.

Notes on Feature and Configuration Support

» “Feature Support” on page 19
* “Multi-Display Setup: Tips and Requirements” on page 20

Feature Support

* Toaccess NVIDIA nView-based features using the nView Desktop Manager
driver, you need

a multi-display graphics card based on any of the NVIDIA GPUs that
support multiple displays on a single graphics card, as indicated in Table
2.5, and

at least two display devices connected to the card.
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* Other non-nView features are supported by either single-display or multi-
display NVIDIA GPU-based cards; i.e., you can connect only one display
device, such as a monitor, and access these features, provided the NVIDIA
GPU supports these features.

* The options shown in the NVIDIA properties panels may vary depending on
the specific NVIDIA GPU you are using. For example, one or more options
that are available for a specific GPU-based card, such as a GeForce4 Ti or
GeForce4 MX, may not be available on a GeForce2 Pro or other types of
products.

Multi-Display Setup: Tips and Requirements

* When using a multi-display setup under Windows 2000/XP, running
Windows in “Dualview” mode is strongly recommended.

*  When running Windows with multiple cards (i.e., two or more NVIDIA
GPU-based graphics card are installed in your computer), note the following:

Using cards based on the same NVIDIA GPU is strongly recommended.
The same NVIDIA driver (version) must be installed for each card.

Note: For details on using multi-display modes, see the ForceWare Release 50
Graphics Drivers User’s Guide.

Multi-Display Configuration: Tips and Requirements

* When running Windows XP or Windows 2000 with more than two active
displays, using “Dualview” mode is strongly recommended.

*  When running Windows with multiple cards (i.e., two or more NVIDIA
GPU-based graphics card are installed in your computer), note the following:

Using cards based on the same NVDIA GPU is strongly recommended.
The same NVIDIA driver (version) must be installed for each card.

Note: For details on using multi-display modes, see the ForceWare Release 50
Graphics Drivers User’s Guide.
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Table 1.1 lists details of supported operating system modes and Desktop
Manager features for Windows 2000, XP, and 9x.

Table 1.1 Multi-Display Mode and Feature Support
Supported Modes and Windows XP
Features Windows 2000 | Windows NT 4.0 Windows 9x
Is there nView Dualview Yes Yes Yes Yes
support (default) for up to nine
(9) display devices?
Is nView Clone mode Yes Yes Yes Yes
supported?
Are nView Span (Horizontal/ | Yes Yes Yes NA
Vertical) modes supported?
Note: In Span mode, a
maximum of two (2) display
devices are supported.
Does switching between No Yes Yes NA
nView Span/Clone mode and
nView Dualview mode require
restarting your computer?
Are all nView Desktop Yes Yes Yes, except Yes, except
Manager features supported? transparency, mouse, transparency,
application bar, gridlines, and
gridlines, and mouse features.
NVKeystone features
Hardware Acceleration? Yes Yes DirectX: Yes Yes
» DirectX operations are OpenGL: Acceleration
accelerated if window is is disabled in Multiview
constrained to a single mode.
monitor otherwise
operation is redirected to
the software.
¢ OpenGL support
Examples in this Guide

* For example purposes, most of the NVIDIA panels shown in this guide
feature the NVIDIA GeForce FX 5900 Ultra GPU-based graphics card. You

may be using a different NVIDIA GPU-based graphics card, in which case

you will see the exact name of the GPU you are using reflected in the
NVIDIA GPU tab.

Note: As noted earlier, in the current Release 50 NVIDIA graphics driver,

NVIDIA Corporation

the nView Desktop Manager control panel can be opened as a
standalone user interface and the exact options can be accessed from
the NVIDIA display properties menu.
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* The example Desktop Manager panels in this guide will show the tabbed
version of the control panel instead of the NVIDIA menu version. See Figure
1.2, “nView Desktop Manager Properties: Tabbed Control Panel vs. Menu
Style” on page 6.

* The Windows XP panels shown in this document apply also to Windows
2000 functionality, unless noted otherwise.

* The Windows Me panels shown in this document also apply also to Windows

98/95 functionality, unless noted otherwise.
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SYSTEM REQUIREMENTS

This chapter contains the following topics:

* “Operating Systems” on page 24

* “Minimum Hard Disk Space” on page 25

* “Software: NVIDIA Graphics Driver” on page 26

* “Optional Software: Internet Explorer” on page 26

* “Optional: System Administrator Access Privileges” on page 26
* “Hardware: Supported NVIDIA Products” on page 27

* “Supported Languages” on page 29

Operating Systems

This release of the nView Desktop Manager driver is designed for the
Microsoft operating systems listed in Table 2.1:

Table 2.1  Operating System Requirements

Operating System Minimum Requirements
Windows XP Home

Windows XP Professional

Windows XP Media Center

Windows XP Media Center Edition 2004

Windows Server 2003 x64

Windows XP AMD64

Windows 2000

Windows NT 4.0 Service Pack 6
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Table 2.1  Operating System Requirements (continued)

Operating System Minimum Requirements
Windows Me
Windows 98 Microsoft DirectX " 5

Note: Windows 98 and Me are collectively called Windows 9x in this guide.

Minimum Hard Disk Space

The minimum hard disk space requirements for each operating system are listed
in Table 2.2, Table 2.3, and Table 2.4.

Table 2.2 Hard Disk Space Requirements — English

Operating System Minimum Disk Space Required
Windows XP 19.2 MB
Windows 2000 19.2 MB
Windows NT 152 MB
Windows Me 19.3 MB
Windows 98 19.3 MB
Windows 95 19.3 MB

Table 2.3 Hard Disk Space Requirements — Non-English Languages

Operating System Minimum Requirements
Windows XP 249 MB
Windows 2000 24.9 MB
Windows NT 24.8 MB
Windows Me 24.8 MB
Windows 98 24.8 MB
Windows 95 24.8 MB

Table 24 Hard Disk Space Requirements — Full International Package

Operating System Minimum Requirements
Windows XP 44.1 MB
Windows 2000 44.1 MB
Windows NT 40.0 MB
Windows Me 44.1 MB
Windows 98 44.1 MB
Windows 95 44.1 MB
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Software: NVIDIA Graphics Driver

Make sure the current version of the NVIDIA graphics driver software for your
Windows operating system has been installed on your computer.

Consult your System Administrator if you are unsure about the version that is
installed.

For further information on driver installation, see “Installing and Uninstalling
the Graphics Driver” on page 30.

Optional Software: Internet Explorer

You must have installed Microsoft Internet Explorer 6.0 or later version in
order to access the “Desktop Explorer” feature as well as specific nView Menu
Options that are available for Internet Explorer. See “Internet Explorer Options”
on page 181.

Optional: System Administrator Access Privileges

You can use nView Desktop Manager with or without System Administrator
access privileges.

Note: However, certain Profiles features require System Administrator
privileges under Windows NT 4.0 and Windows 2000/XP.
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Table 2.5 lists the NVIDIA products supported by the NVIDIA graphics driver
software and the number of displays the GPU-based card supports.

Note: Some Desktop Manager features support only certain NVIDIA GPUs,
which are noted in this table and where applicable in this guide.

Note: The Desktop Manager “transparency” feature works best with NVIDIA
GPUs that have higher performance than GeForce2 GTS.

Table 2.5 Supported NVIDIA GPUs

NVIDIA Desktop Products

NVIDIA Workstation
Products

Number of Displays
Supported Per
Card

nForce™2 §

2— applies to all GPUs
in this category.

nForce2 ST

nForce2 G

nForce2

nForce 420/420D 1— applies to all GPUs

nForce 220/220D in this category.

GeForce FX 5950 Ultra 2 — applies to all GPUs
in this category.

GeForce FX 5700 Ultra Quadro FX 1100 2 — applies to all GPUs

GeForce FX 5700 in this category.

GeForce FX Go5700

GeForce FX Go5750

GeForce FX 5900 Quadro FX 3000 2 — applies to all GPUs

GeForce FX 5900 Ultra in this category.

GeForce FX 5950

GeForce FX 5200 Ultra Quadro FX 500 2 — applies to all GPUs

GeForce FX 5200 Quadro NVS 280 PCI in this category.

GeForce FX Go5100

GeForce FX G05200

GeForce FX 5600 Ultra Quadro FX Go700 2 — applies to all GPUs

GeForce FX 5600 in this category.

GeForce FX 5600 SE

GeForce FX Go5600

GeForce FX 5800 Ultra Quadro FX 2000 2 — applies to all GPUs

GeForce FX 5800 Quadro FX 1000 in this category.

GeForce4 Ti 4800 Quadro4 980 XGL 2 — applies to all GPUs

GeForce4 Ti 4800 SE Quadro4 780 XGL in this category.

GeForce4 Ti 4200 Quadro4 Go700

GeForce4 4200Go
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System Requirements

GeForce3 Ti 500
GeForce3 Ti 200

Number of Displays
NVIDIA Workstation Supported Per

NVIDIA Desktop Products Products Card
GeForce4 Ti 4600 Quadro4 900 XGL 2 — applies to all GPUs
GeForce4 Ti 4400 Quadro4 750 XGL in this category.
GeForce4 Ti 4200 Quadro4 700 XGL
GeForce4 440 Go
GeForce4 420 Go
GeForce4 410 Go
GeForce3 Quadro DCC 1— applies to all GPUs

in this category.

GeForce4 MX 440 Quadro4 580 XGL 2 — applies to all GPUs
GeForce4 MX 440 SE Quadro NVS 280 in this category.
GeForce4 MX 420 x Quadro4 380 XGL
GeForce4 MX 460 Quadro4 550 XGL 2 — applies to all GPUs
GeForce4 MX 440 Quadro NVS 200 in this category.
GeForce4 MX 440-SE
GeForce4 MX 420

Quadro NVS 400 4 — applies to all GPUs

in this category.

GeForce2 Ti Quadro2 Pro 1— applies to all GPUs
GeForce2 Ultra in this category.
GeForce2 Pro
GeForce2 GTS
GeForce2 MX Quadro2 MXR 2 —applies to all GPUs
GeForce2 MX400 Quadro2 EX in this category
GeForce2 MX200 Quadro2 Go
GeForce2 MX100
GeForce2 Go
GeForce 256 Quadro 1— applies to all GPUs

in this category.

NVIDIA RIVA TNT2™ Ultra
NVIDIA RIVA TNT2 Pro
NVIDIA RIVA TNT2
NVIDIA RIVA TNT2 M64
NVIDIA Vanta™

NVIDIA Vanta LT

1— applies to all GPUs
in this category.

NVIDIA RIVA TNT™

1— applies to all GPUs
in this category.
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The following languages are supported in the NVIDIA panels that are
accessible from the Windows Display Properties > Settings > Advanced

option.

English (USA) German
English (UK) Greek
Arabic Hebrew

Chinese (Simplified) Hungarian
Chinese (Traditional) Italian

Czech Japanese
Danish Korean
Dutch Norwegian
Finnish Polish
French

NVIDIA Corporation

Portuguese (Brazil)
Portuguese (Euro/Iberian)
Russian

Slovak

Slovenian

Spanish

Spanish (Latin America)
Swedish

Thai

Turkish
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INSTALLING AND UNINSTALLING
THE GRAPHICS DRIVER

This chapter contains the following major sections:

» “Before You Begin” on page 30

* “About the Graphics Driver Installation” on page 31

* “Uninstalling the Graphics Driver” on page 32

» “Using the NVIDIA Graphics Driver Menu” on page 33

Before You Begin

30

In order to access the NVIDIA Display Properties tabs, the latest version of the
NVIDIA graphics driver for your Windows operating system must be installed
on your computer.

+ If you do not have System Administrator access privileges, it is assumed that
the appropriate person with System Administrator access in your
organization will set up and install the NVIDIA graphics driver software on
your computer.

 This chapter discusses the installation process but does not provide step-by-
step instructions on how to perform an actual installation.
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About the Graphics Driver Installation

The nView Desktop Manager feature is part of your NVIDIA graphics driver
installation files and, therefore, is automatically installed when the NVIDIA
graphics driver software is installed.

NVIDIA Driver Installation provides both an . inf file-based installation
method and an InstallShield Wizard-based installation method.

File Locations

* The installation process copies all necessary files for operation into the
appropriate directories.

* The nView system files are copied to your Windows\System directory.

* Predefined nView Desktop Manager (. tvp) profile files are saved in the
Windows\nView directory.

Note: Under Windows 2000/XP, new profiles that you create are saved in the
Documents and Settings\All Users\Application Data\
nView Profiles directory.

» As part of the installation process, an uninstall is registered in your system.

* Under Windows Me and Windows XP, the NVIDIA driver is installed in
“Dualview” display mode. However, note that the second display is not
activated (turned on) by default. You need to enable it. For details on
enabling Dualview mode, see the ForceWare Release 50 Graphics Drivers
User’s Guide.

* Under Windows 2000, the NVIDIA graphics driver software is installed in
Span mode for all NVIDIA GPU-based graphics cards, except Quadro the
NVS series cards, which are installed in Dualview mode.

Preserving Desktop Manager Settings Before Upgrading
Your Software

You can preserve your Desktop Manager settings by using profiles when you
upgrade your software.

Follow the steps below and/or refer to the NVIDIA nView Desktop Manager 2.0
User’s Guide for details.

1 Before uninstalling or installing software, save your current nView Desktop
Manager settings to a new profile.

For example, name this profile “My Settings”.
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Open the Profiles directory.

You should see your new profile . tvp file in this directory; for example, My
Settings.tvp.

You can copy this file to a disk in your A: drive or to a different directory on
your hard drive.

Uninstall the currently installed NVIDIA graphics driver software on your
system. See details in Uninstalling the Graphics Driver below.

5 Install the new version of the NVIDIA graphics driver software.

6 Copy your profile . tvp file back into the Profiles directory.

Start nView Desktop Manager and load your profile.

When you load this profile, all your nView Desktop Manager settings,
including Individual Settings you may have set up for applications, are
restored.

Uninstalling the Graphics Driver

32

Note: It is highly recommended that you follow the steps in this section to

completely uninstall the NVIDIA graphics driver before installing a new
version of the software.

To uninstall the NVIDIA graphics driver software, follow these steps:

1

a A W DN

From the Windows taskbar, click Start > Settings > Control Panel to open
the Control Panel windows.

Double click the Add/Remove Programs item.

Click the NVIDIA graphics (display) driver item from the list.
Click Change/Remove.

Click Yes to continue.

A prompt appears asking whether you want to delete all of the saved nView
profiles.

If you click Yes, all of the nView software and all of your saved profiles
will be deleted.

If you click No, the nView software is removed, but the profile file are
saved in the Windows\nView directory on your hard disk.

Your system now restarts.
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Using the NVIDIA Graphics Driver Menu

Once your NVIDIA graphics driver software is installed, you can access the
NVIDIA graphics driver features that are available on the Media Center menu
by using the procedures that are explained and illustrated in this section.

1 From your Windows desktop, right click to display the desktop menu and
click Properties > Settings (tab) and then Advanced.

You will see the name of your NVIDIA GPU on a tab (Figure 3.1).
Figure 3.1 NVIDIA GPU Tab
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2 Click the NVIDIA GPU tab, which displays the name of the NVIDIA GPU-
based graphics card that is installed on your computer.

The NVIDIA menu appears as shown in Figure 3.2.

3 To toggle between hiding and showing the menu, click the green button on
the NVIDIA menu.

(Figure 3.2 also shows the GPU panel with a hidden menu.)

4 Click the scroll bar (Figure 3.2) and drag it left or right to view the entire
contents of the longer menu names.

Note: You can right-click on the scroll bar to see tool tips (Figure 3.2).
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Figure 3.2 NVIDIA Display Properties Menu: Expanded with Scroll Bar and Hldden
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From the NVIDIA menu, you can access all the NVIDIA properties panels
where you can configure the following NVIDIA graphics driver features.

* nView Display Mode. This option does not appear if you have only one
display device attached. It appears only when you have more than one
display device attached.

* Performance and Quality Settings
* Direct3D Settings

* OpenGL Settings

* Overlay Controls

* Troubleshooting

* NVRotate

¢ Full Screen Video

* NVRotate

* Temperature Settings. This option is available only with the GeForce FX
GPU and only if the feature is enabled on GPUs that are older than the
GeForce FX)

¢ Screen Menus

* Desktop Manager. For details on using the Desktop Manager features, see
the nView Desktop Manager User’s Guide for the Release 50 driver.

To view any of the properties panels, simply click the choice on the menu.
Figure 3.3 shows a sample nView Display Modes panel for Windows 2000/XP
and Figure 3.4 shows one for Windows Me/9x.

NVIDIA Settings Utility

The NVIDIA Settings is a new application that can be used in place of the
NVIDIA display properties menu described earlier.

You can access NVIDIA Settings by clicking the NVIDIA Settings icon, which
you can optionally add to the Windows taskbar.

This taskbar utility menu items that provide access to the same display settings
that the regular NVIDIA menu contains, in additional to direct access to certain
application-specific options such as those for nView Desktop Manager,
OpenGL and Direct3D customized settings, and others.

For details on enabling the NVIDIA Settings icon, see “Using the NVIDIA
Settings icon” on page 67.
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Figure 3.3 NVIDIA Display Properties: NVIDIA Menu (Windows XP/2000)
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Figure 3.4 NVIDIA Display Properties: NVIDIA Menu (Windows 9x)
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Chapter 4

Using the Desktop Manager Setup Wizard

USING THE DESKTOP MANAGER
SETUP WizARD

This chapter contains the following major sections:

“About the Setup Wizard” on page 38

“About Using the Setup Wizard” on page 42

“Auto-Launch Wizard Pages After First-Time Installation” on page 43
“Desktop Management Wizard Pages” on page 52

“Desktop Management Wizard Pages for NVIDIA Quadro GPU-based
Graphics Cards” on page 57

About the Setup Wizard

38

The nView Desktop Manager Setup Wizard is a series of dialog boxes that
guides you in setting the most common global settings for window, desktop, and
application management.

Each Wizard page (window) contains descriptive text for a specific option and,
in some cases, an illustration that shows the effect of the option; for example,
window repositioning or spanning. You can also chose to skip major option
groups.

There are two nView Desktop Manager Wizards.
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Multi-Display Auto-Launch Wizard: Multi-Display vs.
Single-Display Setup

The Multi-Display Setup Wizard automatically launches after a first-time
NVIDIA driver installation when there are at least two display devices attached.
After this initial wizard launch, you cannot access this particular wizard until
you uninstall the NVIDIA driver and then reinstall.

If you are setup with a multi-display configuration (i.e., you have more than one
display device connected), the first time you start Windows on your computer
after installing the NVIDIA Windows graphics driver software, the Wizard
starts automatically. On subsequent Windows sessions, you can start the
Wizard from the Wizard option on the nView Desktop Manager properties
Desktop Management panel.

Note: If you are setup with only a single display device, the first time you start
Windows on your computer after the installation of the NVIDIA
Windows graphics driver software, the Wizard does not start
automatically. You can start the Wizard option from the Desktop
Management panel on the nView Desktop Manager control panel, as
shown in Figure 4.3.

Manually Starting the Wizard Using the Wizard Option

If you want to use the nView Desktop Manager Wizard affer the Multi-Display
Setup Wizard has gone through the auto-launch process, you have to invoke the
nView Desktop Manager Wizard using the Wizard option from the Desktop
Management panel on the nView Desktop Manager control panel, as shown in
Figure 4.3.

This sections contains the following topics:

* “Enabling nView Desktop Manager From the Windows Control Panel” on
page 40

o “Starting the Wizard from the nView Desktop Manager Desktop
Management Panel” on page 42
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Using the Desktop Manager Setup Wizard

Enabling nView Desktop Manager From the Windows Control
Panel

Note: If you haven’t yet enabled nView Desktop Manager (i.e., when you right

click on your Windows desktop, you do not see nView Properties as a

menu option), follow these steps; otherwise, go directly to “Starting the

Wizard from the nView Desktop Manager Desktop Management Panel”
on page 42.

From your Windows desktop, click Start > Settings > Control Panel.

Locate the NVIDIA nView Desktop Manager icon and double-click it to
display the Desktop Management panel (Figure 4.2).

To enable Desktop Manager, click the Enable nView Desktop Manager
check box and click Apply. Figure 4.3 shows the Desktop Manager Desktop
Management panel after Desktop Manager is enabled.

From your Windows desktop, right click to display the properties menu,
which will now contain the nView Properties option (shown earlier in
Figure 5.1).

Figure 41 nView Desktop Manager Enabled: nView Properties Appear on Desktop
Menu

Arrange [cons By b
Refresh

niiew Propertes

My¥eystone k

Praopertiss

5 Once you have loaded Desktop Manager, to unload it, uncheck the Enable

nView Desktop Manager check box on the Desktop Manager Desktop
Management tab (shown in Figure 4.2 and Figure 4.3) and click Apply.
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Figure 4.2 Default Desktop Managment Panels: Tabbed and Menu Views
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Figure 43 Desktop Management Panels After Enabling Desktop Manager
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Using the Desktop Manager Setup Wizard

Starting the Wizard from the nView Desktop Manager Desktop
Management Panel

Note: If nView Desktop Manager is already enabled, follow these steps;
otherwise, see “Enabling nView Desktop Manager From the Windows
Control Panel” on page 40.

1 Right click from your Windows desktop and click nView Properties.
2 From the Desktop Management tab that appears (Figure 4.3), click Wizard.

About Using the Setup Wizard

42

The figures in this section show a few examples of the step-by-step Wizard
pages you will see when running the Desktop Manager Wizard.

Use the following guidelines when using the Wizard:
* Use the Back and Next options to navigate through the windows.

» Carefully read the content of each Wizard page, which serves as a quick
overview of key Desktop Manager features and lets you enable/disable
certain key features by clicking an option.

» Ifyou enable a feature, note that you can change this setting later through the
Desktop Manager control panel tabs or menu options,

 If you do not want to enable one or more features in a given window, click
Next to go to the next window.

Notes Before You Begin

There may be some variation in the number and type of Wizard windows that
appear, depending on your configuration; i.e., whether you are running
Windows Me/9x (limited Desktop Manager features), multiple displays or
single-display connected, and so on.

* For example, if your system only has one display device connected and no
gridlines defined, Window Management Wizard pages (e.g, Figure 4.24
through Figure 4.26) will not appear.

* Also note that because transparency is not a supported feature under
Windows 9x or Windows NT 4.0, the Wizard page containing this option
(Figure 4.28) will not be available under those operating systems.
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Auto-Launch Wizard Pages After First-Time Installation

The auto-launch Wizard pages in this section are automatically launched when
you start up your Windows desktop after a first-time installation of the NVIDIA
graphics driver software. Use these wizard pages to:

* Set up multiple-displays
* Enable and launch the nView Desktop Manager control panel

Note: Based on your display device configuration and the options you choose

on a Wizard page, the Wizard pages you will see may differ from the
examples given in this section.

Figure 4.4 Auto-Launch Wizard Welcome Page

HVIDIA nView Desktop Manager Setup Wizard

Multi-Display Setup Wizard

Thiz wizaid will help pou enable and customize vour
li-dizplay sehup

@ Welcome to the NYIDLA nView

Tocontinue, click Hest

A

\

\

| Mexns jl Cancel ]
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Figure 4.5 Auto-Launch Wizard Setup Option: “Typical Setup” Selected
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Figure 4.6 Auto-Launch Wizard Setup Option: Display Settings for Typical Setup
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Figure 4.7 Auto-Launch Wizard Setup Options Page: “Custom Setup” Selected
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Figure 4.8 Auto-Launch Wizard: Multi-Display Mode Page: Dualview Mode Selected

N¥IDIA nView Desktop Manager, Setup Wizard

Multi-Dizplay Mode

O Sinale

Select a multi-dizplay mode:

() Span

e
(*) Dualview l:l___
-

() Clone

tulti-dizplay modes define hiow your tvea dizplays work, together.

Single dizplay mode.

X

Mative multi-dizplay mode. Each digplay haz ite
own resolution, colour depth and refresh rate.

Dizplays are combined ta create one virtual
dizplay. *rour desktop spans bath displays.

Both dizplays show the zame information.

< Back ”

Mest > ] l Cancel

NVIDIA Corporation

45



Chapter 4

46

Using the Desktop Manager Setup Wizard

Figure 4.9 Auto-Launch Wizard Display Settings Page for Dualview Mode (2 CRT

Example)
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Figure 4.10 Auto-Launch Wizard: Multi-Display Mode Page: Span Mode Selected
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Figure 4.11 Auto-Launch Wizard Display Settings Page for Span Mode (Example 1)
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Figure 4.12 Auto-Launch Wizard Display Settings Page for Span Mode (Example 2)
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Figure 4.13 Auto-Launch Wizard Display Settings Page for Span Mode (Example 3)
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Figure 4.14 Auto-Launch Wizard Display Settings Page for Span Mode (Example 4)
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Figure 4.15 Auto-Launch Wizard Multi-Display Mode Page: Clone Mode Selected
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Figure 4.16 Auto-Launch Wizard Display Settings Page for Clone Mode (2 CRT

Example)
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Figure 4.17 Auto-Launch Wizard Page: NOT Enabling Desktop Manager
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Figure 4.18 Auto-Launch Wizard Completion Without Enabling nView Desktop
Manager
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Figure 4.19 Auto-Launch Wizard: Enabling nView Desktop Manager |
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Figure 4.20 Auto-Launch Wizard Completion Without Enabling nView Desktop
Manager
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Figure 4.21 nView Desktop Manager Control Panel Launched
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Desktop Management Wizard Pages

The Wizard pages in this section are available when you click the Wizard
option from the Desktop Management panel of the nView Desktop Manager
control panel, as sown in Figure 4.2 and Figure 4.3.

Note: Based on your display device configuration and the options you choose
on a Wizard page, the Wizard pages you will see may differ from the
examples given in this section.
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Figure 4.22 Desktop Management Wizard: Welcome Page
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Figure 4.23 Desktop Management Wizard: Profiles Page
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Figure 4.24 Desktop Management Wizard: Window Management Page (1)
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Figure 4.25 Desktop Management Wizard: Window Management Page (2)
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Figure 4.26 Desktop Management Wizard: Window Management Page (3)
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Figure 4.27 Desktop Management Wizard: Enabling nView Desktop Manager Page (1)
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Figure 4.28 Desktop Management Wizard: Window Transparency Page
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Figure 4.29 Desktop Management Wizard: Completion Page
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Desktop Management Wizard Pages for NVIDIA Quadro
GPU-based Graphics Cards

Note: The Wizard pages in this section are available only if you have an
NVIDIA Quadro GPU-based graphics card installed.

You can access these Wizard pages when you click the Wizard option from the
Desktop Management panel of the nView Desktop Manager control panel, as
sown in Figure 4.2 and Figure 4.3.

Figure 4.30 Desktop Management Wizard: Profiles Page for NVIDIA Quadro-based
GPUs (1)
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Figure 4.31 Wizard Window Management Page for NVIDIA Quadro-based GPUs (2)
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ACCESSING AND ENABLING THE NVIEW
DESKTOP MANAGER CONTROL PANEL

This chapter contain the following major sections:
“Overview of Procedure” on page 59:

“Accessing and Enable nView Desktop Manager from the Windows
Control Panel” on page 62

“Enabling and Accessing Desktop Manager from the nView Display
Properties Menu” on page 63

“Enabling Desktop Manager from the NVIDIA Settings Icon” on page 65
“Accessing Windows Display Properties Settings” on page 68
“Troubleshooting” on page 69

Overview of Procedure

You can access the nView Desktop Manager control panel using any of the
following methods:

* Double-click the NVIDIA nView Desktop Manager item from the Windows
control panel.

+ After enabling nView Desktop Manager, right click on your Windows
desktop and choose Properties. Then click Settings (tab) > Advanced >
NVIDIA GPU tab > the Desktop Management menu option.

+ After enabling nView Desktop Manager, right click on your Windows
desktop and choose nView Properties (Figure 5.1).
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Once you have installed the NVIDIA Driver software with the nView Desktop
Manager features, you can enable (load) and disable (unload) the Desktop
Manager control panel using a variety of methods, as discussed in this section:

1 After you enable Desktop Manager (following the instructions in this
chapter), you can right click to display the Windows desktop popup (right-
click) menu, which will now contain the nView Properties option, as shown
in Figure 5.1.

Figure 5.1 nView Desktop Manager Enabled: nView Properties Appear on Desktop
Menu

Arrange [cons By k
Refresh

Faste

Paste Shorteut

niiaw Properites

i eystans
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Figure 5.2 nView Desktop Manager Disabled: nView Properties Removed from
Desktop Menu

2 Click nView Properties to open the nView Desktop Manager properties
panel, which will open on the Desktop Management panel, as shown in
Figure 5.3 and Figure 5.4.
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Figure 5.3 Desktop Management Panel After Enabling Desktop Manager

4 nView Desktop Manager

User Inteface Effects || Zoom || Hat Keys || Mouse || Toaols |
Desktop Management | Profile | Windows || Applications | Desktops |
i View w <
#VIDIA.
[#]Enable ridiew Deskiop Manages
riviews Desktop Manager version information
Filename Description Wersion
MYIEW DLL Desktop Manager hook library  6.14.10.5200
MYSHELL.DLL  Shell namespace library £.14.10.5200
NWVAPPBAR EXE  riview toolbar E.14.10.5200
MYWOMCPLD... Desktop Manager properties ... B.14.10.5200
M2 EXE riew Desktop Manager Set... 614105200
MYTUICPL.CPL  Caontral panel icon program 614105200
MyWDDIDLL Digplay driver interface library E.14.10.5200
MYCPL.DLL Dizplay driver contral panel E.14.10.5200
IEXPLORE EXE  Internet browser program E.0.2800.1108
[ OK l [ Cancel ] App
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| General || Adapter || Monitor

|| Troubleshoot

| Color Management

g GeForce FX Go5600

K=
PowerMizer ~ -WW@W w BVIDIA
NVRotate ez
Refresh Rate Over
Change Resolutions
=~ Desktop Management
Profile
Windows riiew Deskiop Manager version information
Applications Filename D escription Wersion
Desktops MVIEW DLL Desktop Manager hook, lbrary  B.14.10.5200
User Interface MVSHELL.DLL  Shell namespace library E.14.10.5200
Effects NYAPPBAR.EXE  nview toolbar E.14.10.5200
Zoom MWW DMCPL.D... Deskitop Manager properties ... B.14.10.5200
Hot Keys MWwWZ EXE mfiew Desklop Manager Set...  B.14.10.5200
Mouse MVTUICPL.CFL  Control panel icon program E.14.10.5200
N MDDI.DLL Dizplay driver interface library E.14.10.5200
- Tools ~|| | MvCPLDLL Display driver contral panel £.14.10.5200
F | 5 IEXPLORE.EXE  Internet broweser program £.0.2800.1106
@
OK l [ Cancel ] Apply

NVIDIA Corporation

61



Chapter 5 Accessing and Enabling the nView Desktop Manager Control Panel

Note: Several Desktop Manager functions such as performing operations on
multiple windows within an application require Desktop Manager to
be loaded before you start the application.

Note: In the current Release 50 NVIDIA graphics driver, the display
properties options and the Desktop Manager options have been
consolidated to one menu. Therefore, another way to access and enable
nView Desktop Manager is through the Windows Display Properties
Settings tab (as explained in a later section).

Accessing and Enable nView Desktop Manager from the
Windows Control Panel

To access nView Desktop Manager settings from the Windows Control Panel,
follow these steps:

1 From your Windows desktop, click Start > Settings > Control Panel.

2 From the Name column, double-click NVIDIA nView Desktop Manager
(Figure 5.5) to display the nView Desktop Manager properties panel (Figure
5.6).

Figure 5.5 Windows Control Panel With NVIDIA nView Desktop Manager Program
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3 Click the Enable nView Desktop Manager option to check the check box
and click Apply.

The feature tabs are now all enabled, as shown in Figure 5.6.

4 From your Windows desktop, right click to display the properties menu,
which will now contain the nView Properties option (Figure 5.1).
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In the future, you can click nView Properties to open the nView Desktop
Manager window shown in Figure 5.6.

5 If you disable the Enable nView Desktop Manager check box that you
enabled in step 3, the nView Properties option is removed from your
Windows desktop menu, as shown in Figure 5.2.

Figure 5.6 Desktop Management Panel: Before and After Desktop Manager is Enabled
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Enabling and Accessing Desktop Manager from the nView
Display Properties Menu

In the current Release 50 NVIDIA graphics driver, the display properties
options and the Desktop Manager options have been consolidated to one menu.
Therefore, another way to access and enable nView Desktop Manager is
through the Windows Display Properties Settings tab, as follows:

1 From your Windows desktop, right click to display the properties menu.
Then click Properties > Settings > Advanced > the NVIDIA GPU tab and
the Desktop Management option from the NVIDIA menu that appears
(Figure 5.7).

NVIDIA Corporation 63



Chapter 5 Accessing and Enabling the nView Desktop Manager Control Panel

Figure 5.7 Accessing Desktop Manager from the nView Display Properties Menu
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2 Click the Enable nView Desktop Manager check box and click Apply.
Notice that the various Desktop Manager features that previously appeared as
tabs now appear as menu options (Figure 5.8).

The Windows desktop menu now also contain the nView Properties option
(Figure 5.1), from which you can access the fabbed-style nView Desktop
Manager properties (Figure 5.6).

If you disable the Enable nView Desktop Manager check box that you
enabled in step 2, the nView Properties option is removed from your
Windows desktop menu (Figure 5.2).
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Figure 5.8 nView Desktop Manager Enabled on the nView Display Properties Menu
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Enabling Desktop Manager from the NVIDIA Settings Icon

The NVIDIA Settings icon lets you enable and access Desktop Manager and
also easily access the nView Desktop Manager properties windows, including
the feature tabs. Using this icon, you can also access various nView display
properties options such, OpenGL, Direct3D, Color Correction, and NVRotate,
including the Windows Display Properties Settings panel.

Follow these steps to enable the NVIDIA Settings icon from the nView display
properties Troubleshooting panel.

1 Right-click from your desktop to display the properties menu and then click
Properties > Settings > Advanced > the NVIDIA GPU tab >
Troubleshooting option from the NVIDIA menu. Figure 5.9 shows the
Troubleshooting panel.
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Figure 5.9 Troubleshooting
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1 Click the check box Display the NVIDIA Settings icon in the taskbar to
enable the options.

2 Click Apply. The icon is added to the Windows taskbar as shown in Figure
5.10.

Figure 5.10 NVIDIA Settings Icon on the Windows Taskbar
FrBEy 9:23 PM

Windows Taskbar —NVIDIA Settings icon

3 From the Windows taskbar, simply right click the NVIDIA Settings icon and
then select the options you want from the menu that appears (Figure 5.11).
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Using the NVIDIA Settings icon

To use the NVIDIA Settings icon on the Windows taskbar (Figure 5.11) simply
right click the icon and then select the options you want from the menu that
appears. The Desktop Manager menu is shown in Figure 5.11.

1 To enable Desktop Manager, right click the NVIDIA Settings icon on the
Windows taskbar and click nView Desktop Manager > Enable nView
(Figure 5.11).

Figure 5.11 NVIDIA Settings icon: nView Desktop Manager Settings
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2 Again, right click the NVIDIA Settings icon on the Windows taskbar and
click Desktop Manager to confirm that the Enable nView option is now
checked (Figure 5.11).

You can open the nView Desktop Manager control panel by clicking
nView Properties from this menu.

You can view saved profiles by clicking the nView Profiles option

You can view desktops you’ve created by clicking the nView Desktops
option.
3 To disable Desktop Manager, right click the NVIDIA Settings icon on the
Windows taskbar and click Desktop Manager > Disable nView.

4 Again, right click the NVIDIA Settings icon on the Windows taskbar and
click Desktop Manager to confirm that the “Disable nView” option is now
checked.
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Accessing Windows Display Properties Settings

From the Desktop Management panel, click the Display Settings . . option
(Figure 5.12) to access the Windows Display Properties Settings panel.

Figure 5.12 Desktop Management Panel: Accessing the Windows Display Properties
Settings Panel
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Click Display Settings to
open the Windows Display
Properties Settings panel

NVIDIA Corporation



NVIDIA nView Desktop Manager User’s Guide

Troubleshooting

If you have trouble accessing the nView Desktop Manager properties panel,
verify that a current version of the NVIDIA graphics driver software is installed
on your system. You can follow these steps to verify this:

1

From your Windows desktop, right click to display the properties menu and
then select Properties > Settings tab to access the Display Properties
Settings panel.

The “Display” field shows the name of your NVIDIA-GPU based graphics
card; for example, “Monitor name on NVIDIA Quadro2 MXR/EX”.

Click Advanced and the NVIDIA GPU tab.

3 Verify that the “Driver Version Information” box lists the most recent

versions of the NVIDIA driver files. Scroll down to confirm that all files
have the same version number. If there’s any discrepancy, make sure you or
your system administrator uninstalls the NVIDIA driver software according
to the instructions in “Uninstalling the Graphics Driver” on page 32 and then
reinstall the software.

Note: Make sure that the file nvdesk32.d11 does not appear on the Driver

Version Information list of files. This file is now obsolete and can result
in inconsistencies. If you see this file, uninstall the NVIDIA graphics
driver software and then re-install a current version.
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WORKING WITH PROFILES

This chapter discusses the following topics:
* “About Profiles” on page 70

* “Benefits of Using Profiles” on page 72
* “Profiles Options” on page 73

» “List of Profiles” on page 74

* “Current Profile” on page 75

* “Loading a Profile” on page 75

* “Creating a Profile” on page 75

» “Saving a Profile” on page 77

» “Deleting a Profile” on page 77

* “Copying Profiles for Use on Another Computer” on page 78

About Profiles

Profiles features can be used on both single-display and multi-display computer
setups.

Note: Under Windows XP/2000 and Windows NT 4.0, certain options such as
creating, saving and exporting, and deleting profiles are only available to
users with Administrator access rights.

Using Profiles options, you can save all your Desktop Manager settings into a
single file called a profile. To change how your desktop functions, you can
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subsequently load these profiles with a single “hot key” keystroke or by clicking
Load Profile.

A profile can contain all of the settings for nView Desktop Manager, including
multiple desktops and their backgrounds, individual (application) settings, user
interface settings, NVKeystone settings, window management settings, and
display mode settings (e.g., screen resolution, screen refresh rate, etc.).

A profile can also contain:
» QGraphics driver settings (color settings, OpenGL settings, etc).

* A set of applications to launch when loaded (i.e., saving open application
states).

Note: “Open application state” saving is available with GeForce-based
graphics cards, but with a limitation -- up to eight applications states
can be saved and loaded. Quadro-based graphics cards have no limits
to the number of applications that can be saves and loaded.

Profiles are a “snapshot” of all your Desktop Manager settings. There is never
an “active” profile; instead, you can reload your Desktop Manager settings
“snapshot” and then edit it if you need to modify the settings any time in the
future. For example, if you switch computers, upgrade your operating system,
or are configuring an office, you can simply save all your settings to a profile
and then load those settings on any computer that you want.

Note: The profile file is not updated as you change Desktop Manager settings.
Use the Save Profile option to update the profile with your new Desktop
Manager settings.

Note: If you are using an NVIDIA Quadro GPU-based graphics card, the
nView Desktop Manager installation comes with several pre-defined
profiles to get you started quickly. These profiles contain the basic
settings for different user levels and industries. You can start with one of
these pre-defined profiles and tailor it to your own needs.

Note: Under Windows XP/2000 and Windows NT 4.0, several profile-related
options are available to only those users with Administrator access rights.
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About Saving and Restoring Your Display Mode
Information

As mentioned previously, profiles can save and restore your display mode
information, including the number and position of enabled display device, each
display device’s refresh rate, resolution, color depth, etc.

Note: Note, however, that unlike desktop management settings, display mode
settings are dependent upon the hardware in your computer and thus may
not work when transferred between computers. For example, if a profile
was saved with display mode information on a computer that had four
displays connected and is then copied to a computer that has only two
displays connected, then loading this profile on the two-display computer
will not restore the display mode because the physical hardware (i.e., four
displays) does not exist on the computer.

About Saving Open Application States: For Quadro-
based GPUs only

Note: Beginning with the current NVIDIA Release 50 driver under NVIDIA
Quadro-based GPUs only, profiles can also save and load the open
application states.

* A snapshot of all running applications on the system is taken including size,
position, window state, and desktop. When this profile is loaded, all of these
applications are restored to their proper positions.

* Microsoft Internet Explorer, Windows Explorer, Office, and Exceed
applications can also have their data state saved when a profile is saved and
restored (when the profile is loaded) including the file/URL/Unix application
with which the application may have been working.

Note: If you save with four Internet Explorer windows open and restore while
you have two Internet Explorer windows open, only two new Internet
Explorer windows will load.

Benefits of Using Profiles

72

Using Profiles features, you can tailor different Desktop Manager modes to
more closely match your operating needs and then easily switch between
profiles with a hot key.

You can use profiles to quickly switch your system configuration, depending on
your needs.
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» For example, if you have a notebook computer that is sometimes docked with
an extra display device and sometimes undocked, you may want to have
dialog boxes pop up on the notebook computer’s screen while undocked but
while docked, have dialog boxes appear on the extra display device. In this
case, you can set up two profiles on your system; a docked version and an
undocked version with different settings. When you switch configuration
(i.e., dock or undock your notebook computer), you can load your
configuration with a single keystroke.

Note: The loaded profile can also include turning on or off an external
display connected to your notebook computer.

+ If you work in a company with an IT department, profiles are even more
useful. For example, a System Administrator can define a custom Desktop
Manager mode and roll it out in one step to a department or other defined
group in the company rather than have to configure each workstation
separately. This can help reduce training and support costs since everyone
within a group or department can use a common Desktop Manager
configuration that is tailored for their needs.

Profiles Options

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Profiles tab or menu option to display the nView Desktop Manager
Windows panel.

Note: Creating (New Profile), saving and exporting (Save Profile) and deleting
profiles (Delete Profile) are only available to users with System
Administrator access privileges.

Note: If you are using an NVIDIA Quadro GPU-based graphics card, additional
pre-defined profiles are provided by NVIDIA and viewable on the
Profiles panel.
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Figure 6.1  Profiles Panel for NVIDIA GeForce-based GPUs
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When you go to the Profiles panel, you will see a list of profiles available for
loading. Each profile in the list may have one of two icons next to it — a lock/
unlock icon (closed or open padlock) and a monitor icon.

* A locked profile cannot have any settings modified when it is loaded. If you
load a locked profile, you will not be able to change your nView settings until
an unlocked profile is loaded. Unlocked profiles have no restrictions.

+ If a profile has a monitor icon next to it, this means that there is display
mode information stored in the profile. See Creating a Profile” below for
more information.

+ If a profile has a application icon next to it, this means that application
states have been saved within this profile. See Creating a Profile” below for
more information.
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Current Profile

The “Current Profile” label (shown in Figure 6.1) simply displays the name of
the last profile you have loaded or saved.

The Profiles panel example in Figure 6.1 shows the Current Profile as “generic”
because generic is highlighted in the list.

Loading a Profile

You can select a profile from the list and select Load Profile to load the profile.

Note: You may see additional profiles set up specifically for your company or
organization if your System Administrator has set up custom profiles and/
or if you are using an NVIDIA Quadro GPU-based graphics card.

Creating a Profile

Click New Profile to create, name, and add a new profile that contains all of the
current nView settings. Once saved, you can reload this profile at any time.

Figure 6.1 show the New Profile dialog box. You can include many NVIDIA
graphics driver options and nView Desktop Management options in the profile
by enabling those options in the New Profile dialog box.

If nView Desktop Manager cannot locate the hardware to support the display
mode stored in the profile (for example, the profile mode information is to turn
on four display devices but the computer that is loading the profile only has two
display devices connected), then the display mode loading will silently fail.

However, note that the nView Desktop Managements settings in the profile will
be loaded.
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Figure 6.2 Creating a New Profile
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Figure 6.3  Profiles Panel After Adding a Profile
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Saving a Profile

Note: Under Windows NT 4.0 or Windows XP/2000, only users with System
Administrator privileges can save (export) profiles.

The Save Profile option lets you overwrite the existing selected profile with
your current nView Desktop Manager settings.

* Predefined nView Desktop Manager (. tvp) profile files are saved in the
Windows\nView directory.

* Under Windows 2000/XP, new profiles that you create are saved in the
Documents and Settings\All Users\Application Data\
nView Profiles directory.

* Once saved, you can reload this profile at any time.

* When you are saving to the profile selected from the list, a warning message
indicates that you are about to overwrite the selected profile.

Click Yes to continue; otherwise, click No.

Deleting a Profile

The Delete Profile option lets you to delete the selected profile.

Note: Under Windows NT 4.0 or Windows XP/2000, only users with System
Administrator privileges can delete profiles.

Note: When you are deleting the profile, a warning message indicates that you
are about to lose all the settings in the selected profile you are about to
delete. Click Yes to continue with the deletion process; otherwise, click
No.

Figure 6.4 Deleting a Profile
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Copying Profiles for Use on Another Computer
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A profile is simply a Desktop Manager data file. Therefore, it can be copied and
pasted like any other file. Profile files are located in the Windows\nView
directory on your hard disk and have a . tvp extension.

To copy a profile file for use on another system, follow these steps:

1 From the Windows\nView directory on your hard disk, copy the . tvp
profile file you want to a desired location, such as a diskette (in drive A:) or
other network location.

2 Then, be sure to paste this file to the Documents and Settings\All
Users\Application Data\nView Profiles directory on the computer
where you plan to load this profile.

3 When you access the Desktop Manager Profiles settings on this new
computer, you will see the name of the profile you just copied.

4 Select the profile and click Load Profile to load this profile.
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MANAGING WINDOWS

This chapter discusses the following major topics:
* “About Windows Options” on page 79

* “Windows Panel Options” on page 80

* “Window Settings” on page 81

» “Dialog Box Settings” on page 82

About Windows Options

The nView Desktop Manager Windows panel contains features that only apply
to multi-display configurations.

Note: The options on this panel will be disabled (grayed) if you are using only
one display.

A key benefit of using windows management features is that you no longer have
to spend your time resizing, relocating, or searching for windows because you
can specify how you want your windows to function. You can specify how you
want windows to operate on your desktops and/or display devices.

For example, when you maximize an application under Span mode, it stretches
across all display devices, which can be quite inconvenient. Using Windows
management features, you can change this functionality to make the window
only maximize to a single display device. Conversely, under Dualview mode,
where windows normally maximize to a single screen, you can make
applications maximize to the entire desktop.
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Windows Panel Options

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Windows tab or menu option to display the nView Desktop
Manager Windows panel.

Note: Under nView Standard and Clone modes, the options on the Windows

panel will be disabled (grayed out) because they do not apply in those
nView modes.

Figure 7.1 Windows Panel in nView Dualview Mode

Options available in nView Dualview mode

Additional option available in nView Span mode
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Figure 7.1 shows the nView Desktop Manager Windows panels. The panel

image on the right shows an option specific to nView Horizontal or Vertical
Span mode.

Note: Windows options do not apply, and therefore are not available, in nView
Clone mode.

Figure 7.2 shows options that are specific to NVIDIA Quadro-based GPUs.

80
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Figure 7.2 Windows Panel Options for NVIDIA Quadro-based GPUs
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Window Settings

Note: Be sure to click apply after enabling any of the below settings.

Enable Window Spanning Across Displays

This option allows windows to span (appear across) displays. When the option
is disabled, all windows are prevented from spanning displays.

Default: Option is enabled (checked).

Enable child window spanning across displays

To access this option, you must first activate the Enable window spanning
across displays option.

Note: If you disable this option, all child windows are prevented from spanning
displays even if the parent window does.

Default: Option is enabled (checked). This means that child windows can span
displays.
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Open window on
This option allows you to set the display device on which you want applications
to open, by default.

To select the display on which you want to open application windows, click the
list and select an item.

¢ Default display
* Last display is the display upon which you closed the application.

Note: If you select Last display, the application state (including the
application window maximize or collapse state) is also restored when
the application opens.

» Start display is the display containing the Start button.

Prevent windows from opening off-screen
Enable this option to prevent windows from opening off the screen.

Limit taskbar to a single display

Note: This option is available only when your nView Display Mode panel is set
to nView Horizontal or Vertical Span mode. It does not apply under
nView Dualview mode and therefore is not available.

When this option is enabled, you can limit the taskbar to a single display instead
of having it stretched across displays.

Default: The option is disabled (unchecked).

Dialog Box Settings

82

Note: Be sure to click Apply after enabling any of the below settings.

Enable dialog box repositioning

This option lets you specify the location of dialog boxes.

Default: Option is disabled.

Move to display n
Enable this option and then specify the display device (click the up/down arrow
to specify the display device number) to which you want to move dialog boxes.
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Move to display where cursor appears
Enable this option if you want to move dialog boxes to the display device that
contains your cursor.

Move to display where application appears
Enable this option if you want to move dialog boxes to the display device that
contains your application.

Center dialog box on display

Enable this option (check box) to force dialog boxes to be centered on their
target display.

NVIDIA Corporation
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MANAGING DESKTOPS

The following major topics are discussed in this chapter:
* “About Desktops Options” on page 84

* “Accessing the Desktops Tab” on page 85

* “Notes Before You Begin” on page 86

* “Desktops List” on page 86

* “Creating Desktops” on page 86

» “Activating or Switching Desktops” on page 88

* “Renaming Desktops” on page 90

* “Removing Desktops” on page 90

* “Properties: Changing Wallpaper and Desktop Icons” on page 90
» “Using nView Desktop Explorer” on page 95

* “Advanced Options” on page 103

About Desktops Options

You can use the Desktop Manager “Desktops” tab to create and configure up to
32 different “virtual” desktops whether you are using a single monitor or
multiple monitors.

If you are using a single monitor, you can create a lot of space by distributing

one or more applications among different desktops to prevent application clutter
on your window. Desktop Manager reduces your desktop clutter by letting you
easily move applications to other desktops thus avoiding the need to open/close
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or minimize/maximize applications in order to navigate between them. So,
window clutter is reduced without compromising performance or using extra
keystrokes.

You can assign customizable names to desktops you create and easily switch
between desktops using assigned hot keys, the Windows Explorer-based
Desktop Explorer, or even the NVIDIA Settings icon, as explained later in this
chapter.

A variety of methods to create, customize, manage, rename, remove, and switch
between multiple desktops, as well as easily move applications from one
desktop to another are discussed in this chapter.

Accessing the Desktops Tab

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on

page 59.

2 Click the Desktops tab or menu option to display the nView Desktop
Manager Desktops panel (Figure 8.1).

Figure 8.1 Desktops Panel

4 nView Deskiop Manager
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Notes Before You Begin

* Desktop options Add, Properties, Rename, and Remove take immediate
effect when clicked.

» Each desktop is identified by a name and can have optional customizations,
such as independent backgrounds or icons that identify the desktop in menus
and in the Desktop Explorer.

* Windows Control Panel-based nView (Desktop Manager) Properties,
command prompt windows, and modal dialog boxes are visible on all
desktops. All other applications, by default, launch only on the active desktop
unless you have set up individual settings for the application.

* nView does not support different resolutions per desktop. All desktops are
automatically set at the same resolution.

* The type of background (wallpaper) selected for your desktop can
significantly affect how fast you can switch from one desktop to another. For
further details, see the “Note” in “Properties: Changing Wallpaper and
Desktop Icons” on page 90.

Desktops List

The Desktops list box displays a list of all currently available desktops.

* Desktop Manager maintains a minimum of one desktop and a maximum of
32 desktops. By default, there is always one desktop named “Default”; this is
the desktop on which you start up.

» The Default desktop is listed first, followed by all other desktops in
alphabetical order.

Note: If you disable Desktop Manager, you are returned to the Default desktop
and all open windows are moved to the Default desktop.

Creating Desktops

Multiple desktops can be created either from Desktops panel using the “Add”
option, as explained below, or the Explorer shell extension.

Each desktop can be assigned a unique name.

Note: You cannot add duplicate desktop names.
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Using the “Add” Option

1

From the Desktops panel (Figure 8.1), click Add. The “Create a new
desktop” dialog box prompts for a name of the new desktop (Figure 8.2).

If you want to add a Wallpaper background and/or assign the desktop a
unique “Icon”, go the next steps.

Otherwise, click OK to complete adding the desktop and return to the
Desktops panel where you will see the new desktop added to the Desktops
list.

After you enter the desktop name, optionally, you can assign the desktop a
Wallpaper background and/or assign the desktop a unique icon.

For details, see “Selecting a Background for the Desktop” on page 91,
“Selecting Separate Backgrounds Per Display” on page 92, or “Selecting a
Desktop Icon” on page 92

Figure 8.2 Creating a Desktop

4 Create a new desktop... Ll Enter a name for the

desktop.

Desktop namme; EM}'NEWDESHDD -

Select a dizplay on which you want ta . Display 1 wallpaper.
change the wallpaper. |

Allows different wallpapers per dizplay

Chooze how the wallpaper appears on the desktop: ;StrEtChV_l

Desktop wallpaper for display 1: [ Bronvze. . ][ Clear ]

EI::\WINNT\Web\WaIIpaper\Purple flower.jpg I

Diesktop icon: Q | Change lcon.. | [ Clear ]

| CAWINNT \spstem32ASHELL32.dI i

[ 1] 4 ][ Cancel ][ Apply ]

Note: If you have checked the Enable Desktop Explorer option from the

Multiple Interfaces tab, you can also use the Desktop Explorer node in the
Windows Explorer to create desktops. See “Creating Desktops from
Desktop Explorer” on page 102.
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Figure 8.3 Viewing the Added Desktop
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Activating or Switching Desktops

88

From the “Desktops” tab, double-click the desktop you want to activate from
the list of desktops.

Note: The type of background (wallpaper) selected for your desktop can
significantly affect how fast you can switch from one desktop to another

For further details, see the “Note” in “Properties: Changing Wallpaper and
Desktop Icons” on page 90.

You can also use a variety of other methods to switch between desktops as
discussed in these sections:

* “Activating Desktops from the NVIDIA Settings icon” on page 89

* “Activating Desktops From the Windows Desktop Properties Menu” on
page 89

» “Activating Desktops from Desktop Explorer” on page 90
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+ “Activating Desktops With Hot Keys” on page 90

Activating Desktops from the NVIDIA Settings icon
To activate desktops from the NVIDIA Settings icon (Figure 8.4), follow these
steps:

Figure 8.4 NVIDIA Settings icon

en & v o006

NVIDIA Settings icon

1 Right click the NVIDIA Settings icon from the Windows taskbar, choose
Desktop Manager > nView Desktops to display the list of your desktops.
Figure 8.5 shows an example of a list of desktops.

Note: If nView Desktop Manager is disabled, you cannot access the nView
Desktops option. In this case, right click the NVIDIA Settings icon
from the Windows taskbar, click Desktop Manager > Enable nView.
Again, right click the NVIDIA Settings icon from the Windows
taskbar, then click nView Desktops.

2 Choose the desktop you want to activate.
Figure 8.5 Accessing Desktops Through the NVIDIA Settings icon
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1 GL Custom OpenGL Settings
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Disable nView
B @ Custom Colour Settings

»

»

ﬂ; Custom Direct3D Settings L4
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| €4 nView Properties .
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3 Desktop C I
I Desktop B
h v Desktop A §
Default

nview Desktops

n¥iew Profiles

roperties
| About NVIDIA Settings...
| Exit

Activating Desktops From the Windows Desktop Properties
Menu

1 Confirm that Desktop Manager is enabled.
2 Right click from your Windows desktop to display the properties menu.
3 Choose nView Desktops to view a list of your desktops.

4 Choose the desktop you want to activate.
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Activating Desktops from Desktop Explorer

See “Renaming, Deleting, and Activating Desktops from Desktop Explorer” on
page 96.

Activating Desktops With Hot Keys
See “Using Hot Keys” on page 150.

Renaming Desktops

Click Rename to rename the selected desktop from a text-input dialog box
where you can type in a new name for the selected desktop.

Note: You cannot rename the Default desktop.

You can perform the same function from the Desktop Explorer; see “Renaming,
Deleting, and Activating Desktops from Desktop Explorer” on page 96.

Removing Desktops

Click Remove to remove the selected desktop from the list.

Once you delete a desktop, it is removed from the list of desktops. The
applications on the deleted desktop now move to the Default desktop.

Note: You cannot remove the startup (or default) desktop.

Y ou can perform the same function from the Desktop Explorer; see “Renaming,
Deleting, and Activating Desktops from Desktop Explorer” on page 96.

Properties: Changing Wallpaper and Desktop Icons

90

The Properties option lets you change the background of the selected desktop
and assign an icon to represent the desktop.

1 From the Desktops panel, select the desktop for which you want to change
the background and/or icon.

2 Click Properties to open a dialog box where you can set or change the
background wallpaper and icon. From this dialog box, you can perform the
following optional tasks, as shown in Figure 8.6:

Browse for different wallpapers (graphics files)

When using multiple display devices, choose separate wallpapers for each
display device.
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Figure 8.6 Changing Properties for Multiple Displays
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Selecting a Background for the Desktop

1 To assign a background to the desktop, click Browse.
2 Select a graphics file to use.

Note: The type of background (wallpaper) you select for your desktop can
significantly affect how quickly you can switch from one desktop to
another. Desktop switching performance from fastest to slowest based on
types of desktop backgrounds is listed below:
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Type of Desktop Background | Fastest to Slowest Desktop
Switching Speed

None Fastest

Bitmap Faster

Active desktop bitmap Fast

Active desktop . JPEG file Slower

Active desktop .HTML Slowest

3 From the drop-down list, click Stretch, Tile, or Center, depending on how
you want the background to be displayed.

The background you select is immediately reflected in the monitor icon in the
dialog box, as shown in Figure 8.6.

Notice that the background change takes effect immediately if you are
modifying your current desktop. If you are modifying a different desktop, the
change is applied the next time you switch to that desktop.

4 If you want to completely remove the background, click Clear.

5 Click OK to return to the Desktops panel, or continue to the next section if
you want to set, change, or remove the icon representation of your desktop.

Selecting Separate Backgrounds Per Display

To select different Wallpapers per display in a multi-display setup, follow these
steps:

1 Click the Allow different Wallpaper per display option to enable (check) it
and click Apply.

2 As shown in Figure 8.6, click the monitor icon (1 or 2) for which you want to
change the Wallpaper, click Browse and proceed according to the steps
shown in the previous section.

3 To change the Wallpaper for the second display, repeat the previous step.

Selecting a Desktop Icon

To assign an icon to a desktop, follow these steps:
1 Click Change Icon.
2 Select a graphics file to use.

Notice that the selected icon is immediately reflected by the icon image, as
shown in the example in Figure 8.6.
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3 If you want to completely remove the icon, click Clear.

4 Click OK to return to the Desktops panel.

Multiple Desktop Global Options

To display the Multiple Desktop Global Options dialog box (Figure 8.7) click
Options from the Desktops panel.

Figure 8.7 Multiple Desktop Global Options Dialog Box
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Show Desktop Name When Switching

Default: Option is disabled (unchecked).

If this option is enabled, when you switch desktops, the name of the desktop to
which you switched will be shown for approximately two (2) seconds on every
display device in your setup; then the desktop name will fade out.

Note: In Span modes (and Multiview mode in Windows NT 4.0), the desktop
name is only shown on one display.
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Enable Desktops in Windows Explorer

When this option is enabled, you can view desktops in the Windows Explorer
folder tree.

1 Enable (check) this option to add the Desktop Explorer node to your
Windows Explorer.

2 Click Apply for the setting to take effect. A prompt appears asking you to log
off for the change to take effect (Figure 8.8).

Figure 8.8 Desktop Explorer Prompt

Desktop Explorer x|

/ Wou rmust log off inorder o enable or disable the Deskiog Explorer
i Press Yes to log off now, No to ignore your change

3 Click Yes to log off for the change to take effect, or No to ignore your
change.

If you just enabled the Desktop Manager Explorer extension, once you log
back in, it will be visible in your Windows Explorer window. A sample
Desktop Explorer view is shown in Figure 8.9.

Figure 8.9 Desktop Explorer Nodes in Windows Explorer
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If you disabled the Desktop Manager Explorer extension, once you log back
in, it will be removed from your Windows Explorer window

Note: The Desktop Explorer requires an installed version 6.0 or later of Internet
Explorer. Note that while Internet Explorer 6.0 must be installed to use
the Desktop Explorer, you can still use other web browsers for browsing
the Web. For details on using the Desktop Explorer, see “Using nView
Desktop Explorer” on page 95.

Using nView Desktop Explorer

Activating the Enable Desktop Explorer adds a new Desktop Explorer node
in the Windows Explorer tree (Figure 8.10), with each defined desktop being
represented as a child node (with its name and icon) of the Desktop Explorer
parent node.

When a desktop node is selected, the content pane can displays the applications
present. To see the graphical representation of the desktop itself, you need to
select the Desktop Explorer (parent node).

The active applications are displayed as leaves of each corresponding desktop
node, allowing drag and drop and other common Explorer functionality.

The following topics are discussed in this section:
* “Creating Desktops from Desktop Explorer” on page 95

* “Renaming, Deleting, and Activating Desktops from Desktop Explorer” on
page 96

* “Enhancing the Desktop Explorer “Thumbnails” View” on page 97

* “Using the Thumbnail Styles” on page 98

* “Moving Applications Between Desktops or to a New Desktop” on page 98
* “Accessing Other Application Settings from Desktop Explorer” on page 100

Creating Desktops from Desktop Explorer
To create and add a desktop using the Desktop Explorer, follow these steps:

1 Right click Desktop Explorer in the Folders list, as shown in Figure 8.10.
2 Click New Desktop to display a dialog box to enter the desktop name.

3 Type the new desktop name (Figure 8.11) and click OK. The new desktop
appears as a new desktop under Desktop Explorer.
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Figure 8.10 nView Desktop Explorer: Main Popup Menu
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Figure 8.11 Entering a Desktop Name

Renaming, Deleting, and Activating Desktops from Desktop

Explorer
Using the Desktop Explorer, you can also rename, delete, and activate (switch
to) a selected desktop.

1 Right click the Desktop name in the Explorer window to display a popup
properties menu, as shown in Figure 8.12.

2 Click one of these options:

Activate: This option immediately switches you over to the selected
desktop.

Delete lets you delete the selected desktop.
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Figure 8.12 nView Desktop Explorer: Desktop Popup Menu
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Rename lets you rename (in edit mode) the desktop name.

Under Windows NT 4.0, clicking Rename displays a Rename Desktop
dialog box in which you can enter a desktop name. Click OK when you
are done and the new name replaces the old one in the Explorer window.

Properties: Click this option to open the Desktops panel.

Enhancing the Desktop Explorer “Thumbnails” View

From the Desktop Explorer window, click the View menu to see a variety of
styles you can choose to view your folders, files, and desktops in the content
pane of the Explorer window. These styles include Lists, Icons, Details, and
Thumbnails.

Note: In addition to the basic views offered by Windows Explorer, if you
choose the Thumbnails view from the Desktop Explorer View menu,
nView Desktop Manager provides a number of Thumbnail styles you can
choose to display the desktops you have created.

Thumbnail style choices are:

* Screenshot shows an actual image of the desktop including wallpaper and
windows. Note that this style requires the most processing power. Also note
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that the image displayed is a snapshot of the desktop when you switched
from it is only updated when you switch from it, it does not dynamically
update.

Geometry shows the desktop wallpaper along with a wire frame view of the
windows on the desktop. This thumbnail style dynamically updates as
windows are opened and closed on the desktop.

Wallpaper shows the desktop wallpaper only per desktop.
Disabled shows the desktop icons only.

Using the Thumbnail Styles
To use the Thumbnail styles for your desktops, follow these steps:

1

From the Desktop Explorer window, click the View menu and then the
Thumbnails option to enable the Thumbnails option (if it isn’t already
enabled).

Click the icon labeled Desktop Explorer in the folder tree of your Explorer
window to expand the folder so that you can view your desktops in the
contents pane.

Then right click on the desktop for which you want to configure Thumbnail
styles. A popup menu appears as shown in (Figure 8.12).

Click Thumbnails and then select one of these styles: Disabled, Wallpaper,
Screenshot, or Geometry (Figure 8.13).

Not all thumbnail styles are supported by all operating systems. However,
Windows XP supports all styles.

Moving Applications Between Desktops or to a New Desktop

Note: If you enabled adding nView options . . on the User Interface panel, you

can also move applications between desktops using the application’s
nView menu options. See “nView Menu Options” on page 121 and
“nView Menu: Description of Options” on page 124 for details.

You can use any of the following methods to “move” or “add” applications
from one desktop to another:

To move applications from one desktop to another, you can use your mouse
to drag and drop applications from one desktop to another.
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Figure 8.13 nView Desktop Explorer: nView Desktop Thumbnails Styles
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* To move or add application between desktops, you can highlight an
application listed in a desktop and right click to display a properties menu, as
shown in Figure 8.14. Then follow these steps:

Click Send to (to move) or Add to (to add) followed by an existing
desktop to which you want to move the application or add the application.
The application will then appear under the desktop you selected.

If you want to create a new desktop on which you want to place the
application, click New Desktop, enter the name of the new desktop in the
dialog box that appears, and click OK. The application will appear under
the new desktop.
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Figure 8.14 nVIew Desktop Explorer: “Send to Desktop n” Application Settings
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Accessing Other Application Settings from Desktop Explorer

Using the Desktop Explorer, you can access a few application-specific settings

as explained below.

Note: If you enabled adding nView options . . on the User Interface panel, you
can also access these application-specific options using the application’s
nView menu options. See “nView Menu Options” on page 121 and
“nView Menu: Description of Options” on page 124 for details.

* Visible on all desktops

To access this option, follow these steps:

Right click an application in a desktop to display a properties menu, as

shown in Figure 8.14.

Then click Visible on all desktops to check the option and enable it.

Notice that the application now appears under each of your desktops, as

shown in Figure 8.15.
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Figure 8.15 nView Desktop Explorer: After Setting “Visible on all desktops”
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e Collapse to <desktop name>

Once you enable the Visible on all desktops option for an application, you
can undo the process by limiting the availability of the application to only
one desktops. To do so, follow these steps:

Right click the instance of the application that appears in the desktop in
which you want the application to remain.

From the properties menu that appears, click Collapse to <desktop
name>, as shown in Figure 8.16.

Notice that the application is removed from all desktops except the one

under which you wanted the application to remain, as shown in Figure
8.17.

* Properties. Click Properties (Figure 8.16) to open the Applications panel.
For details on using the Applications settings, see “Managing Applications:
For Advanced Users” on page 172.
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Figure 8.16 nView Desktop Explorer: “Collapse to Desktop n” Application Setting
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Figure 8.17 nView Desktop Explorer: Affer Setting “Collapse to Desktop n”
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Advanced Options

» Using the Add to desktop option, you can place an application on any
number or subset of desktops.

For example, if you had four desktops named “Default”, “Desk2”, “Desk3”,
and “Desk4” and you had an application on Default, you could Add it to
Desk3. After adding the application to Desk3, the application would exist on
Default and Desk3 but not on Desk2 and Desk4.

* Using the Remove from desktop option, you can remove an application
from an individual desktop.

Maximize Desktop Switching Speed

Enabling this option results in the very quick switching between desktops by
forcing the current wallpaper background on all desktops and disabling different
resolutions per desktop.

Show Command Prompt Windows on All Desktops

When your enable this option, every command prompt window shows on every
desktop. When you disable this option, command prompt windows only appear
on the desktop on which they were opened.

Force Desktop to Redraw in One Step

When you enable this option, desktops are redrawn in one step when you switch
desktops. However, this action may slow down the desktop switching
speed.

Allow Desktop to Use Different Resolutions

When you enable this option, you can set different screen resolutions for each of
your desktops.

Reset Desktops to the Current Resolution

Click Reset to reset all your desktops to the resolution of your current desktop.
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USING THE USER INTERFACE OPTIONS

This chapter contains the following major sections:

* “About User Interface Options” on page 104

» “Accessing the User Interface Tab” on page 105

* “General Options” on page 106

* “Windows and Applications Options” on page 116

About User Interface Options

The User Interface options let you control the nView Desktop Manager user
interface and how it is applied to windows.

For example, using the User Interface options, you can control the following:
» Addition of button features to your Windows application title bars

* Auvailability of options on the nView options menu.

* How nView notifies you of changes in your desktop state

* How nView Desktop Manager is displayed on the Windows desktop
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Accessing the User Interface Tab

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the User Interface tab or menu option to display the nView Desktop
Manager User Interface panel (Figure 9.1).

Figure 9.1  User Interface Panel
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General Options

Enabling General Options

Enable nView Options in the Windows Right-click Menu
This option controls whether the nView Properties and nView Desktop menu
choices appear in your Windows desktop “right-click” menu.

To disable this menu choice, uncheck the check box.

Default: Option is enabled (checked). It is recommended that you keep this
option enabled.

Show Notification Messages on Taskbar
This option controls whether a balloon help notification message is displayed on
the taskbar when a major change in the nView desktop state occurs.

For example, transparent windows are not compatible with Direct3D
applications and must be disabled when a Direct3D application starts. If
notification messages are enabled, then if a Direct3D application starts and
nView Desktop Manager needs to turn off transparency, a message will pop up
informing you of this change.

Enable nView Task Switcher
When this option is enabled, nView adds a desktop switcher in addition to the
standard application tab switcher.

By default, this additional “switch desktop” functionality is accessed through a
Alt-~ keystroke combination which you can change through options in the Hot
Keys panel. See “Using Hot Keys” on page 150.

Enable nView Toolbar

The nView Desktop Manager toolbar lets you place the following items
profiles, actions, and desktops on a dockable toolbar from which you can
access these features with a single click of a button.

e Actions
* Desktops
¢ Profiles

From the User Interface panel, click Enable nView toolbar and then click
Apply. An nView toolbar appears on your desktop.

Figure 9.2 through Figure 9.14 show a variety of nView toolbar menus and
options.
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Note: The nView toolbar functions just like any other Windows toolbar, such as
the Windows taskbar. For details on how to work with the nView toolbar,
you can refer the Windows Help for working with Windows toolbars and
the taskbar, in particular.

Figure 9.2 Appearance of the Enabled “Default” nView Toolbar: “Show title” mode.
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Figure 9.3 Actions: Show Text Enabled; Profiles: No Text/Title Enabled
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Figure 9.4 Actions and Profiles: Show Text and Show Title Are Both Disabled.
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Figure 9.5 ScreenTips text for an Action Toolbar Button.
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Flgure 9 6 Appearance of Proﬁles Actions, and Desktop Menus in nView Toolbar.
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Figure 9.7 nVIew Toolbar: View Menu.
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Figure 9.8 nView Toolbar: Toolbars Menu.
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Figure 9.9 nView Toolbar: Attach Menu.
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When you click Customize from the Actions menu shown in Figure 9.10, the
Windows-based Customize Toolbar dialog box appears, as shown in Figure
9.11.

Figure 9.11 Customize Toolbar Dialog Box: Available from the Actions Menu Only.
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Figure 9.12 nView Toolbar: Desktops Menu with Show Text/Title Enabled.
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Figure 9.13 nVIew Toolbar: Profiles Menu with Show Text/Title AND Show Text
Only Enabled.
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Figure 9.14 nView Toolbar: Actions Menu with Show Text/Title AND Show Title
Only Enabled.
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Figure 9.15 nView Toolbar: Profiles Menu with Show Title Enabled.
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Enable Display Gridlines

When this option is enabled, you can define grids on each of your displays
which act as sub-monitors for the purposes of dialog repositioning, window
spanning, and maximizing.

To create grid lines:

1 Check the Enable display gridlines check box, then click Edit Grids. The
Edit Display Gridlines dialog appears

Figure 9.16 Edit Display Gridlines.

Edit Display Gridlines
Chooze the dizplay which you want
to edi

I:Zli:s:pla_l,l'l V| [ Cancel ]
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2 Click the arrow and select the display on which to set up your gridlines, then
click OK.

The Grid and Anchor Settings screen appears over the darkened desktop.

3 Follow the instructions in the Grid and Anchor Settings menu to create
gridlines.

Figure 9.17 shows a desktop with one horizontal gridline and one vertical
gridline that are used to create three “sub-monitors”.

Figure 9.17 Gridlines Setup (1): Grid and Anchor Settings

Anchor Off

Show Grid Names
Use Grids With...
Exit

4 To set up other grid controls, click Use Grids With. The Use Grids With
screen appears.
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Figure 9.18 Gridlines Setup (2): Use Grids With
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5 Click Return to Last Menu when done.

6 From the first menu screen, click Exit to return to the desktop.

Windows and Applications Options

Adding the nView Desktop Manager Title Bar Buttons

Adding nView Desktop Manager title bar buttons to application windows, as
explained in the sections below, provides easy access to nView Desktop
Manager features including the following:

* the nView options menu
» awindows minimization (collapse to title bar) button and

* desktop/monitor maximizing commands (max to desktop, max to monitor).

Show Button for nView Options

1 To enable this option, click to check the Enable nView menu options title
bar button check box.

When you enable this option, every application window’s title bar will
contain an nView Desktop Manager options menu button, as shown in Figure
9.19.
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2 Click the nView options menu button from the application’s title bar to
display the nView options menu (Figure 9.19).

Figure 9.19 Accessing the nView Desktop Manager Options Menu Using the nView
Options Menu Button

Click the nView options menu button from the application’s title bar to
display the nView Desktop Manager; options menu.
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Note: When you disable (uncheck) this option, the nView Desktop Manager
menu button is not displayed in the title bar of applications. In this case, if
you still need to access the nView options, you can use the nView
Options title bar option to access the nView options, only if you enabled
this feature on your User Interface tab.

Show button for full-desktop maximize

Note: This option is displayed if you are in nView Single Display, Dualview, or
Clone mode (Figure 9.20).

When you enable this option, the nView full-desktop maximize button (square
on the left of the title bar icons in Figure 9.21) is added to title bars on all
application windows.

From your open application, you can click this button to toggle a custom
maximized state for your application window in multi-display configuration. In
nView Dualview mode, the application window maximizes to the full desktop.
on which the application is located.
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Figure 9.20 User Interface Panel Options (2)
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“Show button for single-display maximize” option

Show button for single-display maximize

Note: This option is displayed if you are in nView Span (Horizontal or Vertical)
mode under Windows 2000/XP (Figure 9.20).

When you enable this option, the nView single display maximize button (square
on the left of the title bar icons in Figure 9.21) is added to title bars on all

application windows.

From your open application, you can click this button to toggle a custom
maximized state for your application window in multi-display configuration.

In nView Span (Horizontal and Vertical) modes under Windows 2000/XP,
the application window maximizes to the entire screen of the single display
device on which the application is located.
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Figure 9.21 Application Title Bar (Full Desktop or Single Display) Maximize Button
Full-Desktop Maximize (Single-Display Maximize) button
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Show button for “Collapse to Title Bar”

If this option is enabled (checked, as shown in Figure 9.1), the “Collapse to
title bar” button is added to the application title bar (shown in Figure 9.23).

When you click this button (shown in Figure 9.23), the window shrinks in size
to just its title bar (or the smallest size possible for the window) as shown in
Figure 9.22. When you click the button again, the window is restored to its
former size, also shown in Figure 9.22.

Default: Option is disabled (unchecked). The button is not added to
applications’ title bars.

Figure 9.22 Window Appearance Using the “Collapse to Title Bar Button”
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Clicking the “Collapse to title bar” button causes the application window to only
show its title bar.
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About the Title Bar Buttons LED Status Indicators

In addition to allowing quick access to controls, the nView button bar also
provides status LEDs on each side.

* On the [eft side of the nView button bar is a LED that is either off or red.

When the LED is off, this means that the application does not have any
nView Desktop Manager functions disabled for the window.

When the LED is red (shown in Figure 9.23), then certain nView Desktop
Manager functions for the application window are disabled.

Note: To determine the Desktop Manager functions that are disabled, open
the nView options menu for the application and select “About this
app...”.

Figure 9.23 LED Indicator and nView Options Menu Button
Red and white LED indicators

nView options menu button "~
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" LED indicator = off means
global nView Desktop Manager
settings are in effect.

* On the right side of the nView button bar is a LED that is either off or white
(shown in Figure 9.23).

When LED is off, the window uses global nView settings.

When LED is white, the application has individual (application) settings
defined for it.
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About the nView Options Menu

You can access Desktop Manager features quickly and easily from any
application using the nView options menu. Every window has a system menu
for basic tasks such as moving or resizing the window. Desktop Manager
extends this menu to add features such as making the window transparent or
moving the window to another display device or desktop.

You can also access nView application-specific options from the system menu.
For example, with certain applications such as Internet Explorer 5.0, you can
create links between two Internet Explorer windows.

Note: The features available on the nView Options menu are described in detail
in “nView Menu: Description of Options” on page 124.

Add nView Options to System Menus

To enable the “nView options” menu item for each of your applications, follow
these steps:

1 From the User Interface panel, click the check box Add nView options to
system Menus to add the nView options to every application’s system menu.

2 Click Apply.
3 You can now use one of two methods to display the nView options menu:

Right click an application’s title bar and click the nView options menu
item

or

Right click the application icon in the Windows task bar and click nView
options.

nView Menu Options

nView Desktop Manager can perform a variety of operations on windows in the
system. You can access this functionality through an nView Options menu, as
explained in the earlier sections.

Figure 9.25 shows the dialog box that appears when you click Options. From
this dialog box, you can change the nView Desktop Manager options that you
want to display in the nView options menu. In this way, you can customize your
nView options menu to only show those features that you want to use.
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Figure 9.24 Accessing the nView Desktop Manager Options Menu

Click nView Options from the application’s title bar as another way
to display the nView Desktop Manager options menu.
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Right click the application name/icon from the Windows task bar and click nView Options to display
the nView Desktop Manager options menu.

The options that appear in this dialog box correspond to those available from the
nView options menu that’s available from your application, as shown in Figure
9.25.

Note: If you do not want to have all options available, enable/disable (check/
uncheck) one or more options, as needed. Once you disable (uncheck) an
option, you will no longer see the option in the nView Options submenu
for that application.

Enable or disable one or more of the following options by clicking the check
box next to each option to insert or remove the check mark.
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Figure 9.25 nView Menu Options Dialog Box
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Note: For detailed descriptions of each of these options, see “nView Menu

Options” on page 121.

* nView maximize (Shift Max)
* Send windows to display »
¢ Send application to display »
* Send windows to desktop »

* Send application to desktop »

* Transparent

¢ Always on top

¢ Visible on all desktops.
¢ Collapse to this desktop

¢ Individual settings

* Click Enable All Options if you want to enable all of the above options.

* Click Disable All Options if you want to disable all of the above options.

* Click Enable Multi-Desktop Options if you want to add only the multiple

desktop-specific options.
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* Click Disable Multi-Desktop Options if you want to remove only the
multiple desktop-specific options.

nView Menu: Description of Options

This section explains the nView options that are available from an application’s
nView options menu and part of the configurable nView Menu Options dialog
box (Figure 9.25).

nView Maximize

This option performs the same action as the max/restore title bar option that you
can add as explained earlier in this chapter. This option maximizes the
application window to the current display or to the entire desktop; depending on
whether you are running in nView Dualview or Span mode.

Send window to. ..

* Monitor n: A popup menu displays the number (#) of active display devices
in your setup. Select a display device number, which will represent the
display to which you want the window to move.

* Desktop n: A popup menu displays each defined and active desktop name,
represented by #, including selections for the default and current desktop.
Select a desktop. The active window will be sent that desktop.

Send application to . . .

* Display n: A popup menu displays the number (7) of active display devices
in your setup. Select a monitor number, which will represent the monitor on
which you want the application to move.

* Desktop n: A popup menu displays each defined and active desktop name,
represented by n, including selections for the default and current desktop.
Select a desktop. The application will be sent to that desktop. For an
application that has more than one window (e.g., Microsoft Outlook), every
owned window of the active window (or active window parent) is moved to
the selected desktop or monitor.

Transparent (alpha blended)

Click this check box to toggle transparency on/off for the window.

Always on top
Click “Always on top” to toggle the option on/off for the window.
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When a window is marked as being always on top, it will always be placed in
front of any other window. So you can use this settings on windows that you
don’t want to appear behind or obscured by other windows.

If two windows have the “Always on top” enabled and they are dragged on top
of one another, then the last active window is placed in the top position.

Visible on all desktops
Click Visible on all desktops to toggle the visibility (on/off) of the window on
all desktops.

Enabling this option causes the window to appear on all desktops.

Collapse to desktop

Note: This option is only available if the application has the Visible on all
desktops option enabled.

Enabling “Collapse to desktop” disables the “Visible on all desktops” option
and moves the active application window to the current desktop.

Individual Settings

Note: In order to see the Individual Settings option enabled on the nView
Options menu on an application’s title bar, you need to have checked
(enabled) the Individual Settings option in the nView Menu Options
dialog box, as explained in “nView Menu Options” on page 121 and
shown in Figure 9.25.

* Enable lets you turn on/off the individual settings for the application without
losing those settings.

e Edit: To edit individual settings for an application, select Individual
Settings > Edit on an application’s nView option menu.

Note: To set up individual settings for an application, click Individual
Settings from the Applications panel. For further details, see
“Individual Settings” on page 125 and “Individual Settings” on
page 179.

When you choose to set up individual settings for an application, the
Individual Application Settings dialog box appears (Figure 9.26). From this
dialog box, you can set up both individual window settings as well as launch
settings for the application.

Each window management or dialog box management setting can have one
of three states:
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* On means that the feature is always enabled for this application and may be
represented by a solid colored square, a check mark (as shown in the example
in Figure 9.26) or other indicator, depending on the application.

» Off means that the feature is always disabled for this application and is
always represented by an empty square; unchecked.

* Global means that the application uses the standard nView Desktop Manager
settings for the feature and may be represented by a check mark, solid
colored square (as shown in the example in Figure 9.26) or other indicator,
depending on the application.

Note: The Allow transparency and draw at n% option is simply an on/off’
setting that either enables or disables transparency for the application and
sets an individual transparency level to be used for the application during
transparent operations.

Figure 9.26 Individual Application Settings Dialog Box: 2 Examples
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Individual Settings: Clear all
Clear all displays the message in Figure 9.27.

Figure 9.27 Prompt for Clearing Individual Settings for an Application

n¥iew Propertics

Are you sure you want ba cheer sl pesition memory and individuzl settings for this applcation?

* Click Yes only if you want to erase all individual settings that Desktop
Manager may have stored for the application.

« Otherwise, click No.

Individual Settings: Other Methods of Clearing
You can also use the following means to clear all Individual Settings for an
application:

* Load a profile, which resets your application database.

» Use the Remove option on the nView Desktop Manager Properties
Application panel. (See “Managing Applications: For Advanced Users” on
page 172.)

Menu Options
When you click Menu Options, the nView Menu Options dialog box (Figure
9.25) opens.

See “nView Menu Options” on page 121 and “nView Menu: Description of
Options” on page 124 for details.

About this Application ...
This nView menu option appear only if an nView Desktop Manager function is
disabled for the application.

Note: Selecting this option will open an information box that will describe the
nView Desktop Manager feature that is disabled. A sample “About this
Application” is shown in Figure 9.28.

Application-specific nView Menu Options

In addition to the standard nView menu options described above, certain
applications have custom features available for them on the nView options
menu. Note that when an application has special nView Desktop Manager
features enabled, the “About this application...” option will be displayed on
the nView options menu and will provide a brief description as to how to use the
feature.
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Figure 9.28 Sample “About this Application” Information Box
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USING EFFECTS

The following major topics are discussed in this chapter:
* “About Effects” on page 129

» “Accessing the Effects Tab” on page 130

» “Require Shift key to be held down” on page 131

* “Windows Color Keying” on page 132

About Effects

The Desktop Manager Effects panel provides 2D and 3D features for windows
on the desktop. Effects features can be used in both single-display and multi-
display computer setups.

Among the features you can enable from the Effects panel is increasing the
speed of windows opening/closing and to change Windows behavior to
automatically activate windows underneath your cursor. You can also add
transparency support to windows on the desktop.

Key benefits of using Effects features are that
* Speed up maximizing, minimizing restoring, and opening windows.

» Making a window transparent effectively gives you more space on your
desktop
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Accessing the Effects Tab

Using Effects

1 If you need help accessing the nView Desktop Manager control panel, see

“Accessing and Enabling the
page 59.

nView Desktop Manager Control Panel” on

2 Click the Effects tab or menu option to display the nView Desktop Manager
Effects panel (Figure 10.1 and Figure 10.2).

Figure 10.1 Effects Panel for NVIDIA GeForce-based GPUs
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Window Drawing Enhancements

Make Windows Minimize and Maximize Faster

This option accelerates opening
windows.

, maximizing, and restoring application

Make Windows Transparent When Dragged

This option enables window transparency when windows are dragged.
Windows become transparent as you hold down the mouse option while on the
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window’s title bar, allowing you to quickly see what is underneath the window.
When you release the mouse option, the window becomes opaque.

Figure 10.2 Effects Panel for NVIDIA Quadro-based GPUs
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Require Shift key to be held down

If you want to perform the “Make windows transparent when dragged”
action while holding down the Shift key, enable the Require Shift key to be
held down option.

Enable Taskbar Transparency

This option makes the desktop taskbar transparent

Transparency Level

This option sets the degree of transparency for the transparency features above.
The higher the percentage you select, the more transparent the window appears.

Note: You can change the transparency level of an individual application using
the Individual Settings feature. For details, see Chapter 14, which
discusses the features of the Applications panel.

Note: Transparency percentage values are limited to a maximum of 80%.
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Notes on Transparency Support

* Transparency is only supported on Windows 2000/XP.

* Transparency can take a lot of processing power. If Desktop Manager detects
that your system may be sluggish when dragging large transparent windows,
you will be given an option to disable transparent window dragging for
windows larger than a certain size.

» Transparency is disabled when a 3D or hardware overlay application is
running.

» Some applications do not support transparency, in which case, an About this
application . .. menu choice is added to the nView Extension menu for that
application.

Windows Color Keying

Note: Color Keying options are available only when using NVIDIA Quadro-
based GPUs.

Enable Windows Color Keying

When you enable this option, nView Desktop Manager colors the border of
application windows according to:

+ Individual Application Settings (if you have enabled this option, see
“Individual Settings” on page 125 and/or “Individual Settings” on page 179)
or

* Automatically assign colors. . option described below.

Manipulating Color-Keyed Windows Using Hot Keys

Color keyed windows can then be manipulated using color-keyed hot keys that
you can define using options on the Hot Key panel. When you press a color-
keyed hot key combination, it will toggle the corresponding color-keyed
window to be brought to the forefront, maximized, and visible on all desktops.
In other words, it allows for a window to be immediately accessible with a
single keystroke no matter where on the desktop(s) the window is located.

For details, see “Using Hot Keys” on page 150.
Automatically Assign Colors to Windows

When enabled, nView will automatically color key windows that are open on
the desktop using enabled colors not used by individual application settings.
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Colors will be automatically chosen out of the color pool as long as colors are
available. If all colors have been used, new windows will not be colored.

Using the Color Key table
To enable, disable, or edit any of the colors in the Color Key table (shown in

Figure 10.1), follow these steps:

1 Double-click any of the colors to display the Color Key Properties dialog box
shown in Figure 10.3.

Figure 10.3 Color Key Properties
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2 To disable the color to be used with the Color Keyed windows, click the
checked box to remove the check mark and click OK. Notice that the color
for that number (in this case “4”) is removed from the Color Keyed table in
the Effects panel.

3 To enable a color, follow these steps:

Click a uncolored box number (“4” in this case since it was disabled in the
previous example) to display the Color Key Properties dialog box again.

Click the Enable the color key ..... check box to insert the check mark.
Click OK.
4 To edit the color to be used with the Color Keyed window, follow these
steps:

From the Effects panel, double-click the color number you want to edit.
Click the Edit Color options from the Color Key Properties dialog box.

Choose the color you want from the Color palette dialog box and click OK
to return to the Color Key Properties dialog box. Notice the new color is
reflected in the Current Color field.

5 Click OK. Notice the new color for the number is reflected in the Color Key
table on the Effects panel.

Colored Application Window Borders

Figure 10.4 shows sample applications with colored window borders.
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Figure 10.4 Sample Colored Application Window Borders
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USING Zoom OPTIONS

This chapter contains the following sections:

* “About Zoom Options” on page 136

* “Accessing the Zoom Tab” on page 137

» “Zoom Features: Display Properties vs. Desktop Manager” on page 138
* “Zoom Window Styles” on page 139

» “Using the Mouse Wheel to Change Zoom Levels” on page 139

* “Showing the Cursor in a Zoom Window” on page 140

* “Automatically Moving Zoom Window to the Next Screen” on page 140
* “Enabling Bi-Directional Editing” on page 140

* “Inverting the Colors of the Zoomed Image” on page 141

* “Zooming Video Playback (disables overlay)” on page 141

* “Showing the Zoom Window” on page 141

* “Full Screen Video Zoom” on page 149

About Zoom Options

136

Zoom window shows you a user definable zoom area of your desktop

The Zoom feature of Desktop Manager provides dynamic zoom functionality on
the desktop. Zoom features can be used by both single-display and multi-display
users. Among the zoom features you can enable from the Zoom panel is a

resizable “zoom window” to zoom in on areas of the desktop for easier reading
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or for fine editing. The zoom window shows you a user definable zoom area of
your desktop.
Key benefits of using zoom features are the following:

* You don’t have to change resolutions to view and/or edit small graphics or
text — you can simply open up your “zoom” window.

* You can display a portion of your desktop on a second display without
additional hardware.

Accessing the Zoom Tab

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Zoom tab or menu option to display the nView Desktop Manager
Zoom panel (Figure 11.1).
Figure 11.1 Zoom Panel for Magnifying Glass and Center on cursor Zoom Styles
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Figure 11.2 Zoom Panel for Fixed Frame Zoom Style
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Zoom Features: Display Properties vs. Desktop Manager

138

If you are using an NVIDIA multi-display GPU-based graphics card, you have

several zoom options available.

» Ifyou just want a Windows tool that lets you zoom certain areas of the
desktop in a window, use the “Zoom Window” tool described in this section.

» Ifyou are specifically interested in zooming video playing back on your
computer from a DVD or other video source, it is recommended that you use
the Overlay Video Mirroring controls described in the NVIDIA Display
Properties User’s Guide. You can set up Video Mirroring to zoom and
automatically display full-screen video on your second display device.

Note: The nView Desktop Manager Zoom panel contains the Video Mirror
Controls. Clicking this option will give you access to the Overlay
Controls panel where you can set Video Mirror options.

NVIDIA Corporation



NVIDIA nView Desktop Manager User’s Guide

Zoom Window Styles

This selection controls what type of Zoom window you want to open. nView
Desktop Manager supports three types of Zoom windows:

* Magnifying Glass
¢ Centered on Cursor

¢ Fixed Frame

Magnifying Glass

This option creates a magnifying glass style zoom window when you launch a
Zoom Window. The magnifying glass zoom window contains a white square
inside the zoom window. For details on using this option, see “Using
Magnifying Glass Style Zoom” on page 145.

Centered on Cursor

This option creates a zoom window that displays a magnification of the area
around the mouse cursor when a zoom window is launched. For details on using
this option, see “Using Cursor Style Zoom” on page 144

Fixed Frame

This option creates a zoom window that displays a magnification of a fixed area
on your desktop. For details on using this option, see “Using Fixed Frame
Zoom” on page 145.

Using the Mouse Wheel to Change Zoom Levels

» To use the mouse wheel to change zoom levels when a zoom window is
active, enable the “Use the mouse wheel to change zoom levels...” option.

Note: In addition, or as an alternative, you can also use the “Zoom Level”
menu from the Zoom Window to change zoom levels. See “Zoom
Window Menus” on page 142.

* To use the mouse wheel to change zoom levels while holding down one of
the following keys (Shift or Ctrl), follow these steps:

Click the Use the mouse wheel to change zoom levels. . . . check box to
enable the option.
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Then click Shift and/or Ctrl.
Click Apply.

Showing the Cursor in a Zoom Window

Note: This option doesn’t apply under Magnifying Glass zoom.

This option causes the mouse cursor to be shown in the zoom window when
enabled (checked). This feature only applies to centered on cursor and fixed
frame zoom styles. When enabled, the mouse cursor will be shown in the zoom
window if the mouse cursor is in the area of the screen that is being zoomed.
When disabled (unchecked), the mouse cursor will not appear in the zoom
window.

Automatically Moving Zoom Window to the Next Screen

Note: The option Automatically Moving Zoom Window to the Next Screen
does not apply if Magnifying Glass or Fixed Frame zoom window style
is enabled.

When the option Automatically Moving Zoom Window to the Next Screen is
enabled and the zoom window is maximized, nView Desktop Manager will
automatically move the window to the next screen if your cursor moves onto the
Zoom window.

Enabling Bi-Directional Editing

Note: The Enable bi-directional editing option applies only to the
Magnifying Glass and Fixed Frame style zoom windows and cursor-
related functions, but not text editing.

When you enable the Enable bi-directional editing option, you can use your
mouse with applications under either Magnifying Glass or Fixed Frame zoom
windows using the application’s standard mouse-editing methods.

Using an example of the Microsoft Accessories Paint program, (Start >
Programs > Accessories > Paint), follow these steps:

1 Open the Zoom window (see “Showing the Zoom Window” on page 141 for
details) and place the Magnifying Glass or Fixed Frame zoom window over
the Paint window so that the drawing buttons as well as some of the paint
area is being magnified.
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2 Press the paint buttons on the Zoom window (not the paint window) and then
draw directly on the zoom window. This allows for easier editing since the
area is magnified.

Inverting the Colors of the Zoomed Image

Enable the Invert zoomed image option to invert the colors of your zoomed
image.

To use the option, click the option to insert a check mark in the check box and
click Apply.

Zooming Video Playback (disables overlay)

Note: This option doesn’t apply under Magnifying Glass zoom.

The Zoom Window cannot zoom video data contained in hardware overlay
windows. Hardware overlay is used by default to play back video data. Thus if
you open a video playback window, the Zoom window normally will not zoom
the data.

This option lets you disable hardware overlay when the zoom window is open.
This forces video playback not to use hardware overlay.

Note: This setting does not affect videos that are currently playing when the
Zoom window opens but only affects video windows opened after the
Zoom window. In other words, if a video is playing before you open a
zoom window, the video data will not be zoomed. If a video is opened
after the zoom window is open, the video data will be zoomed if this
option is set.

Showing the Zoom Window

This option, when checked, opens a “Zoom Window” that can display a
magnification of a selected area of your screen using the zoom style you have
selected (i.e., “Magnifying Glass”, “Centered on Cursor”, or “Fixed Frame”
style zooming).

* When a Zoom window is open, this button changes to Hide Zoom Window.
Pressing the button when it is labeled “Hide Zoom Window” will close the
open Zoom window.

» Using the Zoom Window, you can change zoom levels, the update rate of the
zoomed data, and even toggle the window on or off with a hot key.
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Using Zoom Options

Zoom Window Menus

The following topics are discussed in this section:
e “Zoom Level” on page 142

* “Zoom Refresh” on page 142

* “Zoom Style” on page 143

» “Using Cursor Style Zoom” on page 144

» “Using Magnifying Glass Style Zoom” on page 145

» “Using Fixed Frame Zoom” on page 145

Zoom Level
Zoom Level can be set from 1x to 10x (Figure 11.3).

Note: You can also change zoom levels with the mouse wheel by itself or in
combination with the Ctrl and/or Shift keys if you selected this option in
the Zoom panel.

Figure 11.3 Zoom Level Menu
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Zoom Refresh

Zoom Refresh can be set from 5 frames/second to 30 frames/seconds, in
increments of 5 (Figure 11.4).

Note: Higher refresh rates require more processing power.
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Figure 11.4 Zoom Refresh Menu
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Zoom Style

Zoom Style can be set to any one of the following settings as shown in Figure
11.1 and Figure 11.5.

* Centered on cursor

* Magnifying glass

* Frame Window

Figure 11.5 Zoom Style Menu
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Using Cursor Style Zoom

1 To use the Cursor style zoom, move your mouse cursor to the area of your
screen (or open application) that you want to zoom.

2 You will see the area magnified in the zoom window, as shown in Figure
11.6.

Flgure 11.6 Cursor Style Zoomed Area in Zoom Window (1)
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Another cursor style zoom window is shown in Figure 11.7 below.
Figure 11.7 Cursor Style Zoomed Area in Zoom Window (2)
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Using Magnifying Glass Style Zoom

1 Enable Magnifying glass zoom style either from the Zoom panel (shown in
Figure 11.1) or (if you already have the zoom window open) from the Zoom
menu (Figure 11.5).

2 If you enabled the option from the Zoom panel, when you click the Show
Zoom Window option from the Zoom panel with the Magnifying glass
option enabled (checked), the magnifying glass style zoom window appears
with a white square inside the window (Figure 11.8).

Figure 11.8 Magnifying Glass Style Zoom Window
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To use the Magnifying Glass style zoom, follow these steps:

1 Adjust the zoom level to increase or decrease the size of the white square. To
adjust the zoom level you can either use the mouse wheel (or the mouse
wheel and the Ctrl/Shift key options) or the Zoom Level menu options on
the Zoom Window.

2 Click on the title bar of the Zoom window and drag the zoom window over
the area on the screen that you want to magnify so that the transparent white
square encompasses the area to magnify. Figure 11.9 shows an example of
the magnifying glass style zoom window covering an area of an open
window. Note the white box surrounding the display area.

3 Release the mouse option. The section of the screen inside the transparent
white square now becomes magnified to fill the entire zoom window. Figure
11.10 shows the result of a magnifying glass zoom.

Using Fixed Frame Zoom

When you click Show Zoom Window from the Zoom panel with the Fixed
Frame option enabled (checked), the Zoom Window opens along with a
second, smaller “zoom source” window labeled “Zoom Window - Fixed
Frame”, as shown in Figure 11.12.
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Figure 11.9 Magnifying Glass Style Zoom Window Over Zoom Area
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Figure 11.11Magnifying Glass Style Zoomed Area in Zoom Window (2)
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To use the Fixed Frame style zoom, follow these steps:
1 Confirm that the Zoom Style is set to Fixed Frame.
2 Click Show Zoom Window.

In the Figure 11.12 example, the small Zoom Window-Fixed Frame “zoom
source” window appears on the right and the resulting magnified area is
shown in the larger Zoom Window.

Figure 11.12Zoom Window-Fixed Frame Window
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3 Move the small “Zoom Window — Fixed Frame” window (labeled in Figure
11.12) to another area of the desktop that you want to zoom.

Note: Now that you have adjusted the position of the Zoom Window - Fixed
Frame “zoom source” window, it is automatically hidden while the
magnified contents are displayed in the large Zoom Windows, as
shown in Figure 11.13.

Figure 11.13Magnified Area in Zoom Window: Zoom Window

Click the Fixed Frame menu to re-display (unhide) the “zoom source”
Zoom Window-Fixed Frame window.
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4 To toggle the Zoom Window - Fixed Frame “zoom source” window on and
off (display or hide), click the Fixed Frame menu option on the main Zoom
Window, as shown in Figure 11.13.

When the Zoom Window is not active, the “zoom source” window will be
hidden but the area where it was last dropped will continue to be zoomed and
shown in the Zoom Window.

To re-display the Zoom Window - Fixed Frame window, click the Fixed
Frame menu option in the main Zoom Window.

Then move the now visible Zoom Window - Fixed Frame window to the
new area of the desktop you want to zoom.”

5 To adjust the zoom level, use either the mouse wheel or the mouse wheel and
the Ctrl/Shift key options or the Zoom Level menu options on the main
Zoom Window.

Note: You can adjust the zoom level to increase or decrease the size of the
Zoom Window — Fixed Frame. In other words, the higher the Zoom
Level you set, the smaller the size of the Zoom Window — Fixed
Frame becomes.
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Note: You can also adjust the zoomed area by resizing the main Zoom
Window.

Full Screen Video Zoom

Note: You cannot use Full Screen Video Zoom if you have only one display
device attached, i.e., your are in nView “Single-Display” mode.

To display full-screen video on one of your display devices,

1 Click the Full Screen Video Zoom option to open the NVIDIA display
properties Full Screen Video panel.

2 Click the Full scree device list.

3 Select Auto-select if the nView Mode list on the nView Display Modes
panel set to nView Dualview or one of the Span modes.

4 Select Primary display or Secondary display if the nView Mode list on the
nView Display Modes panel set to nView Clone mode.

For further details on using the Full Screen Video options, refer to the NVIDIA
Display Properties Desktop User’s Guide: Driver Release 50.
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UsSING HOT KEYS

The following topics are discussed in this chapter:
* “About Hot Key Options” on page 150

* “Accessing the Hot Keys Tab” on page 151

* “Selecting an Action” on page 152

* “Adding a Hot Key” on page 155

» “Removing a Hot Key” on page 158

+ “Removing All Hot Keys” on page 158

» “Active Hot Keys List” on page 158

About Hot Key Options

The Hot Key features can be used by both single-display and multi-display
users.

nView Desktop Manager lets you set up hot keys (shortcut keys or key
combinations.) to access and perform virtually every action of the Desktop
Manager. The key benefits of using hot keys is quick access to common
functions with a single keystroke.

Using the Hot Keys features (Figure 12.1), you can
* View a list of hot keys that you have defined for your system.
* Arranged hot keys in a tree view

* Quickly add, remove, or edit defined hot keys
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Assign multiple hot keys to one action but cannot assign multiple actions to
one hot key

* Copy assigned hot keys to the clipboard

Change the functionality of a hot key from operating on the active window to
operating on the window under the cursor

Accessing the Hot Keys Tab

1 If you need help accessing the nView Desktop Manager control panel, see

“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Hot Keys tab or menu option to display the nView Desktop
Manager Hot Keys panel (Figure 12.1).

Figure 12.1 Hot Keys Panel
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Selecting an Action

152

The Select an Action list box (Figure 12.1) displays a list of actions that can be
performed when you press a key or combination of keys, i.e., assigned hot keys
for the actions.

1

Select an action by clicking it.

2 Use the scroll bar to access the complete list of actions.

The actions and their descriptions are listed below.

3 Go to the section “Adding a Hot Key” on page 155 to assign the hot key to

the selected action.

Windows and Applications Actions

Show on all desktops — toggles the active window between showing on all
desktops or on a single desktop.

Collapse to desktop — causes the active window to show on the current
desktop only.

Move window to display — moves the active window to a user-specified
display.

Move window to next display — moves the window to the next monitor
on your system.

Move window to desktop — moves the active window to a user-specified
desktop.

Max/Restore window — toggles a maximize/restore function on the active
window.

Minimize window — minimizes a window to the taskbar and restore if the
window still selected.

Collapse/Restore window — toggles between collapsing the application
window to its title bar and restoring the window to its former size.

Toggle window Z-order — moves the window to the top if it is not at the top.
Moves window all the way to back if it is on top, but it does not change
activation state of window.

Toggle transparency — toggles the active window between being transparent
and opaque.

Toggle always on top — toggles the active window between being always on
top or not being on top.

Show on all desktops — forces the window to show up on all desktops
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Collapse to desktop — moves the application to the current desktop only and
turns off the “Show on all desktops” functionality.

Show nView options menu — displays the nView options menu for the
currently active window.

Desktop Management Actions

Show desktop name — brings up the desktop name of the current desktop.
Activate desktop... — switches the display to a user-specified desktop.

After you enter the keystroke in the text box and click Add, a list box appears
with all possible desktop targets. Choose a desktop that you will activate or
“switch to” with the hot key you assigned.

Next desktop — switches the display to the next desktop.

Previous desktop — switches the display to the previous desktop.

Window Management Actions

Send all windows to display — gathers all windows on the desktop and
cascades them on the selected display device.

Toggle color-keyed windows — Use this action when you have color-keyed
windows.

When you press the hot key you assigned to this action, the window with
the color key you specified in the action properties will be maximized and
brought to the current desktop.

Press the hot key again and the window will be sent back to its original
position.

Collapse all windows — collapses all windows on the desktop to their title
bars. If all windows are already collapsed, this action restores all windows to
original size.

Display Mode Actions

* Switch to next display device — is functional only in single-display mode

when more than one display device is connected. In this case, your video
display will switch to the next device.

Note: Note that this hot key only works when your display card is running in
single-display mode.
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Toggle TV output — toggles TV output on if TV is connected and you are
running in nView single-display mode.

Toggle LCD scaling — turns LCD scaling on/off if you are using a flat panel
display.

Toggle Clone mode — When running in nView single-display mode, this
action will toggle Clone mode on and off and will cycle through display
devices.

Note: This hot key is only available with Windows XP and only works when
you are in single-display or nView Clone mode.

Rotate display — allows you to rotate display devices or desktops with a hot
key to the same modes available on the NVIDIA display properties
NVRotate panel:

Landscape
Portrait
Inverted Landscape

Inverted Portrait

Display Settings Actions

Show Color-Keyed window — lets you easily control color-keyed windows.
After you define a hot key corresponding to a color (for details, see
“Examples of Actions Requiring Additional Information” on page 156), then
when you press this hot key, it will toggle the corresponding color-keyed
window to be brought to the forefront, maximized, and visible on all
desktops. In other words, it allows for a window to be immediately accessible
with a single keystroke no matter where on the desktop(s) the window is
located.

Toggle NVKeystone mode — toggles the NVKeystone mode between off, on,
and adjust.

Note: NVKeystone must be enabled (checked) on the Tools panel for this hot
key to have any effect.

Show display grid — shows the monitor grid for the monitor the cursor is on.

Edit display grid — allows you to edit the monitor grid which the cursor is
on.

Adjust display brightness/contrast/gamma — allows you to set hot keys to
adjust the display settings up and down as produced by your video card.

Reset gamma, brightness, contrast to default — resets gamma, brightness,
and contrast values to their default.
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Miscellaneous Actions

* Open nView Desktop Manager control panel — opens the nView Desktop
Manager control panel

* Run application... — runs a user-specified application. Note that after
selection, a browse file dialog appears where you can select the program file
you want to run.

* Locate cursor — highlights the area around the cursor allowing it to be
located on the desktop.

* Toggle zoom window — shows and hides the zoom window.

* Toggle zoom type — toggles the zoom window between different types
* Load profile — loads a saved profile.

» Save profile — saves the current or newly created profile.

* nView task switcher — lets you set the hot keys used to switch between
applications and desktops (Alt-Tab, Alt-~ defaults)

* Toggle NVToolbar — lets you toggle the nView toolbar on and off

Adding a Hot Key

Note: Only one action can be linked to a hot key. (If you attempt to add an
action to a hot key that is already defined, an error message appears.)
However, more than one Hot Key can be assigned to the same action.

To add a hot key, follow these steps:

1 From the Hot Keys panel, click Add. A Hot Keys Add properties dialog box
appears (Figure 12.2 shows two examples) that lets you set the “hot key”
keystroke and set any additional information the hot key needs to operate.

Hot key stroke: This text box lets you select the key or combination of keys
you want to use to perform the selected action.

To use the text box, follow these steps:
Click in the Hot Key stroke text box to display your cursor.

Press the key or keys you want to use for the selection action. For
example, if you press the Ctrl key followed by the G key, Ctrl + G
appears in the text box.
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Figure 12.2 Hot Keys Properties Dialog Box Examples
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Properties: Hot keys for certain actions require additional information to be
entered in order to operate.

When these types of hot keys require additional information, the information
is requested in this “Properties” dialog box. The information requested can be
a display, desktop, profile, or an application designation. In the first three
cases, a list of numbered display devices, named desktops, or named profiles
appear from which you can select your choice.
If Desktop Manager requires an application input (e.g., for the “Run
application” hot key action listed in “Selecting an Action” on page 152), a
Browse button appears allowing you to browse for the application.
Also see “Examples of Actions Requiring Additional Information” on
page 156.

2 Click OK when you’ve entered the key strokes., the selected hot key action

and keystroke combination are added to the Active Hot Keys list. Once a hot
key is added, it is active and available for use.

Examples of Actions Requiring Additional Information

“Move window to display...”

An example is the “Move window to display...” action. Before a hot key can be
added for this action, you must use the Hot Keys Properties dialog box (Figure
12.4) to enter the monitor (display device) on which you want the hot key to
move windows
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Figure 12.3 Hot Keys Properties Dialog Box: for “Move window to display...” Action
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“Show color-keyed window”

Another example is “Show Color Keyed window”. Before a hot key can be
added for this action, you must use the Hot Keys Properties dialog box to enter
additional information.

To assign this action to a hot key, follow these steps:

1

Confirm that the “Enable Window Color Keying” option is enabled on the
Effects panel but the “Automatically assign colors to windows” option is
disabled (unchecked). For details, see “Enable Windows Color Keying” on
page 132.

Set up a color for a particular application in the Individual Application
Settings dialog box, as explained in Chapter 11, “Individual Settings” on
page 125 and Figure 9.26.

Then, set up the “Show Color Keyed window” hot key for the corresponding
color by following these steps:

Double-click the Color Key number shown in the Properties dialog box for
the hot key (Figure 12.4).

Edit the color as explained in “Using the Color Key table” on page 133 in
Chapter 8.

Click Apply to add the hot key for this action.

When the application is open and you press the assigned hot key, the
application becomes “Visible on all desktops” so that you can see it on the
active desktop (even if it is not on the active desktop) and is maximized.
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Figure 12.4 Hot Keys Properties Dialog Box: for “Show color-keyed window” Action
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Removing a Hot Key

The Remove option removes the selected hot key from the Active Hot Keys list.
Once a hot key is removed, it is no longer active or available for use.

Removing All Hot Keys

The Remove All option removes all hot keys from the Active Hot Keys list.
Once the hot keys are removed, they are no longer active or available for use.

Active Hot Keys List

The Active Hot Keys list box displays a list of hot keys that have been assigned
and are currently active. Figure 12.5 shows parts of an Active Hot Keys list.

The Active Hot Keys list box displays the hot key itself (for example., Ctrl +
G), the hot key action (for example, “Gather all windows to Mon1”), and then
any further information for that hot key, such as Properties and Application
Name information, if applicable.

Note: Use the scroll bar at the bottom of this list box to scroll to the right to see
all the information columns for a hot key.
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Figure 12.5 Active Hot Keys List
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CONFIGURING MOUSE EFFECTS

This chapter discusses the following major topics:
* “About Mouse Effects” on page 160

* “Mouse Panel Options” on page 161

* “General Settings” on page 161

* “Kinematics” on page 163

About Mouse Effects

160

The nView Desktop Manager Mouse panel contains features that only apply to
multi-display configurations.

Note: The options on this panel will be disabled (grayed) if you are using only
one display.

A key benefit of using windows management features is that you no longer have
to spend your time resizing, relocating, or searching for windows because you
can specify how you want your windows to function. You can specify how you
want windows to operate on your desktops and/or display devices.

For example, when you maximize an application under Span mode, it stretches
across all display devices, which can be quite inconvenient. Using Windows
management features, you can change this functionality to make the window
only maximize to a single display device. Conversely, under Dualview mode,
where windows normally maximize to a single screen, you can make
applications maximize to the entire desktop.

Mouse features include the following:
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* Throw window — allows you the “throw” a window to a screen edge.
Sensitivity can be adjusted by the slider

» Jump dead screen areas causes the mouse to jump dead areas in non-
rectangular multi-display environments (mouse has to be moving at a
reasonable velocity)

» Toggle window Z-order with middle mouse button does the same as the hot
key only with the mouse and to the window the cursor is over

* Auto-activate windows under the cursor

+ Assign mouse movements to trigger different actions

Mouse Panel Options

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Mouse tab or menu option to display the nView Desktop Manager
Mouse panel (Figure 13.1).

General Settings

Note: Be sure to click apply after enabling any of the below settings.

Enable Throw Window Actions

When enabled, this option lets you to throw windows (i.e., while dragging a
window, release the mouse) to screen edges.

Jump Dead Screen Areas

Enabling the Jump dead screen areas option causes the mouse to jump dead
areas in non-rectangular multi-display environments as long as your mouse is
moving at a reasonable speed.
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Figure 13.1 Mouse Panel
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Toggle Window Z-Order with Middle Mouse Button

z-order refers to the visual layering of controls on a form along the form's z-
axis (depth). The z-order determines which controls are in front of other
controls.

Enable the Toggle window Z-order with middle mouse button option lets you
use your middle mouse button (if applicable) to toggle the Z-order of the
window on which your cursor rests.

Automatically Activate Windows Under Cursor

Enable the option Automatically activate windows under cursor to make any
window on which your cursor appears to become active and move to the front of
the window order.

Change window Z-order when activating

When the option Automatically activate windows under cursor is enabled,
this option (Change window z-order when activating) controls whether or not
the window that is auto-activated is brought to the front of the z-order.
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Enable the Change window z-order when activating option to bring the auto-
activated window to the front of the z-order.

Kinematics

Enable Mouse Gestures

In order to use any of the Kinematic options on this Mouse panel, you must first
enable the Enable mouse gestures option. Click the check box and click

Apply.

Gesture Sensitivity

Use the Gesture Sensitivity slider to adjust the sensitivity of the mouse gestures
listed on this panel to which you may have assigned actions.

Require Shift key to be held down

If you want to hold down the Shift key while performing any of the mouse
gestures listed on this panel, enable the Require Shift key to be held down
option

Operate on Window Under Cursor

Enable the Operate on window under cursor option if you want to perform
any of the mouse gestures on the window that appears under you cursor.

Shake Mouse Horizontally

1 To assign an action to the Shake mouse horizontally option, click the list
and select the action you want to assign.

2 Click Apply.

3 When you shake the mouse horizontally, the action you just assigned is
automatically performed.

Shake Mouse Vertically

1 To assign an action to the Shake mouse vertically option, click the list and
select the action you want to assign.
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2 Click Apply.

3 When you shake the mouse vertically, the action you just assigned is
automatically performed.

Rotate Mouse Clockwise

1 To assign an action to the Rotate mouse clockwise option, click the list and
select the action you want to assign.

2 Click Apply.

3 When you rotate the mouse clockwise, the action you just assigned is
automatically performed.
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UsSING TooLS OPTIONS

This chapter contains the following major sections:

* “About Tools Options” on page 166

* “Accessing the Tools Tab” on page 166

» “Display Quality: NVKeystone” on page 167

» “Display Quality: Show Flat Panel Calibration Screen” on page 171

About Tools Options

The nView Desktop Manager Tools panel offers several miscellaneous tools
that can help you be more productive. Included features are NVKeystone to
correct for display keystoning, a flat panel calibration screen used to optimize
the calibration of your analog flat panels, and several windows utilities that can
automatically correct for improper display settings when they occur.

Accessing the Tools Tab

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Tools tab or menu option to display the nView Desktop Manager
Tools panel (Figure 14.1).
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Figure 14.1 Tools Panel
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Display Quality: NVKeystone

The NVKeystone options in the Display Quality section (Figure 14.1) lets you
place your 2D windows desktop onto a 3D surface, which you can then
manipulate to compensate for image distortion caused by poor alignment of
projection screens.

NVKeystone is an anti-keystoning tool that allows you to map your entire
windows desktop onto a 3D surface and then manipulate and “warp” the surface
to compensate for distortion effects of any surface on which you are displaying.

Because NVKeystone is a 3D application that operates on the entire desktop, it
takes a great amount of bandwidth to operate. You may notice that your display
is sluggish or that 3D games run very slowly when NVKeystone is active.

It is recommended that you disable NVKeystone when you are playing games
or using a 3D program.

Enable NVKeystone Display Correction

Click this check box to enable or disable the anti-keystone feature.
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Note: If this option is disabled, NVKeystone menus and hot keys will not work.

Enable NVKeystone Option in Desktop Menu

Click this check box to place a NVKeystone option in the desktop right-click
menu (Figure 14.2) for easy access to NVKeystone.

Note: If you do not enable this option, the NVKeystone option will not be
placed in the desktop right-click menu. In this case, the only way to turn
NVKeystone on/off is by using a Hot Key assignment.

Figure 14.2 NVKeystone Option in Windows Desktop Properties Menu
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Accessing NVKeystone

You can access NVKeystone using one of two methods:

* From the desktop, right-click to access the Properties menu (must enable the
option in tools) as shown in Figure 14.2 or

+ Use a hot key assignment

This section will focus on accessing NVKeystone from the Desktop properties
menu.

Note: Using the Hot Key method is similar to the Desktop Properties method
but only the Hot Key method can rotate between three different modes —
Off, On, and Adjust.

NVKeystone Menu

The NVKeystone menu (Figure 14.2) contains four options — Activate, Adjust,
Options, and Reset.

* Activate turns NVKeystone on and off.
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* Adjust displays the NVKeystone Adjustment Screen. See NVKeystone
Adjustment Screen in the next section for details.

* Options displays the NVKeystone Options dialog box. See “NVKeystone
Options” on page 169 for details.

* Reset resets NVKeystone to its default settings; that is, warping is disabled.

NVKeystone Adjustment Screen

The “Adjustment Screen” (Figure 14.3) lets you adjust the warping of the
display.

You can grab each of the red “hot spots” on the screen with the mouse and then
drag it to warp the display. In addition, you can use your arrow keys to perform
fine adjustments of the corner that you are currently grabbing with your mouse.

Note: Four options are available within the Adjustment Screen: OK, Cancel,
Reset and Options.

* OK lets you exit the Adjustment Screen after automatically saving the
adjustments you have made.

* Cancel lets you exit the Adjustment Screen and discards any adjustments
you have made. Note that your screen then reverts to its state before you
opened the Adjustment Screen.

* Reset resets your screen to default settings; i.e., no warping of the display.

* Options displays the NVKeystone Options dialog box. See “NVKeystone
Options” on page 169 for details.

NVKeystone Options

From your desktop, right click your mouse to display the properties menu, then
click NVKeystone > Options to display the NVKeystone options menu. The
following options can be set:

* Enable video overlay while NVKeystone is running allows video to play
back correctly when NVKeystone is active.

Note: It is recommended that this option remain enabled (checked).

* Automatically turn NVKeystone off if disabled for more than 30 seconds
automatically turns off NVKeystone and unloads it from memory if it is
unused for more than 30 seconds.

When NVKeystone is not active (i.e., the “Activate” option is not checked in
the NVKeystone menu), NVKeystone is still present in your computer's
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memory, however. This allows you to quickly turn on NVKeystone again, if
needed.

Figure 14.3 NVKeystone Adjustment Screen
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+ Enable NVKeystone display filtering enables or disables antialiased
filtering of the NVKeystone image.

» Use sticky mouse clicks when editing turns on “sticky” mouse clicks for the
NVKeystone Adjustment Screen.

Note: “Sticky” mouse click means that you can click once to grab a corner of
the Adjustment Screen and then click again to release a corner instead
of having to hold down the mouse button.

* Apply NVKeystone to display ...lets you to change the display device on
which NVKeystone appears.

Note: If you are running in nView Span or Clone mode, both displays will
have NVKeystone applied. However, if you are running in Dualview
mod, you will have the option to choose a display for NVKeystone.

* Change NVKeystone modes with... lets you change or assign a hot key to
toggle the keystone mode between off, on, and adjust.

Note: You can perform the same hot key assignment from the Desktop
Properties Hot Keys tab. See “Using Hot Keys” on page 150.

Display Quality: Show Flat Panel Calibration Screen

This option (Figure 14.1), when clicked, displays a calibration screen on every
monitor on the desktop. This calibration screen has been designed to optimize
calibration of analog flat panels when using auto-calibrate (or auto-sync)
features available on most flat panels.

Note: This calibration screen is not needed if you use analog monitors (CRTs).
To use this option, follow these steps:

1 Click the Show Flat Panel Calibration Screen. Each monitor will now
display the nView calibration screen.

2 For each analog flat panel, select its auto-calibrate or auto-sync function.
Note: This function varies for each flat panel manufacturer.

3 After auto-syncing each flat panel, press any key to close the flat panel
calibration screens.

Your panels should now be calibrated to their optimum settings.
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MANAGING APPLICATIONS:
FOR ADVANCED USERS

This chapter contains the following major sections:

» “Accessing the Applications Panel” on page 172

* “About the Applications Panel” on page 173

* “Adding an Application” on page 175

* “Removing an Application” on page 176

* “Disabling an nView Desktop Manager Function” on page 179
* “Individual Settings” on page 179

* “Launch Settings” on page 180

Accessing the Applications Panel

1 If you need help accessing the nView Desktop Manager control panel, see
“Accessing and Enabling the nView Desktop Manager Control Panel” on
page 59.

2 Click the Applications tab or menu option to display the nView Desktop
Manager Applications panel (Figure 15.2).
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Figure 15.1 Applications Panel
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About the Applications Panel

nView Desktop Manager can be customized to function differently for each
application. You can set up some applications to maximize to the full desktop
while you can set up others to maximize to a single display.

You can also configure how an application launches. For example, you can
choose a Windows application such as Calculator to always launch
transparently while have Internet Explorer always launch on a specific desktop.

The nView Desktop Manager Applications panel provides a central spot where
you can set up and edit these individual application settings. The Applications
panel also allows you to disable nView Desktop Manager functions for each
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application. While NVIDIA tests hundreds of applications for compatibility,
there may be certain third-party applications that are not compatible with certain
features, such as Transparency or the nView Desktop Manager menu options.
Using the Applications panel, you can disable these features for applications
that are not compatible with these features.

In addition to distinguishing between different applications, nView Desktop
Manager can also distinguish between different Window Classes.

The Applications panel (Figure 15.1) displays a list of all applications and
window classes that are set up for Individual Settings and/or have nView
Desktop Manager functions disabled. Each line in the list box contains a few
elements. The name of the application or class is listed along with an icon to the
left.

 Ifthere is a green check mark on the icon, this means the application has
Individual Settings.

+ Ifthere is a yellow ! on the icon, this means that some nView Desktop
Manager functions are disabled.

 Ifthere is a bold red X on the icon, this means that all nView Desktop
Manager functions are disabled for that application or class.

For example, the list in Figure 15.1shows the following:

* The CicMarshalWndClass has all nView functions disabled.
* The Notepad application has no special settings.

* The Regedit application has some nView functions disabled.
* My Window Class has no special settings.

* The Explorer application has Individual Settings.

Note: When you add a class or an application to the list box, you still have not
set any special settings for it. In this case, the icon (for the class or
application) will be blank as in the Notepad application or My Window
Class as shown in Figure 15.1. If you close the Applications panel now
and reopen, these two list elements will be removed because they had no
special settings applied to them.

Note: Below the list box, in the Selected application’s settings box, a text
description of the selected item in the list is also provided. For the
“Wordpad” application example, the text box correctly states that
wordpad has no Individual Settings but that some nView Desktop
Manager functions are disabled for it.
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Adding an Application

User’s Guide

1 To add an application, click Add to display a dialog box (Figure 15.2) where
you can use the Find or Browse option to locate an application to add to the

list box.

Figure 15.2 Add Application Dialog Boxes (1)
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2 Ifyou want to use the Browse option, click Browse and locate the application

executable file you want to add. Then click Open

3 Ifyou want to use the Find option, make sure that the application you want to
add is open on your desktop. When you click the Find option, another dialog

box (shown in Figure 15.2) appears.

4 Click and drag the circular Finder tool option to the title bar of the open
application you want to add. Then, release the mouse button.

The name of the application appears in the Application field (Figure 15.2).

5 Click OK.
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Figure 15.3 Add Application Dialog Boxes (2)
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Removing an Application

The Remove buttons removes the application or class from the list and also
deletes any Individual Application Settings (IAS) or disabled function
information for the application or class.

At the bottom of the Application tab there is a setting called “Globally disable
individual settings and state memory”. When checked, this option disables all
nView individual application settings throughout the system for all windows.

About Windows Classes

In rare cases, some applications may be written in such as way that either its
main window or, more commonly, their child windows do not support an nView
Desktop Manager feature (such as transparency) or else they do not support a
user making changes to their size and/or position. In these cases, you can
disable nView Desktop Manager functions only for the particular window(s)
that may have support issues.

A class is simply a type of window. Often, window classes are unique to an
application. For example, in nView Desktop Manager, several Window Classes
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are used; for example, a class called “Zoom1” for the Zoom window, a class
called “Child1” for the little white square inside the Zoom window, and so on.

In addition to classes that are unique to an application, there are certain global
classes of windows that are used by every application. An example is a dialog
box that is a global class (the name is #32768 — class names are not always
intuitive).

Note: Using class names, however, allows you to more precisely target
windows for which you want to disable features.

For example, the Zoom1 window class can be set up not to support the
transparency feature. Therefore, there is no need to turn off transparency for all
nView Desktop Manager windows. Also, if another application uses the Zoom1
window class, the transparency rule will still operate.

When a class is selected in the list, the Individual Settings option is disabled.
Classes cannot have Individual Settings enabled; they can only have nView
Desktop Manager functions disabled.

Adding a Window Class

1 To add aclass, click Add to display a dialog box (Figure 15.3) where you can
use the Find option to locate a window class to add to the list box.

2 Before you use the Find option, make sure that the application window (main
or child window) for which you want to add class information is open on
your desktop. When you click the Find option, another dialog box (shown in
Figure 15.4) appears.

3 Click and drag the circular Finder tool option to the title bar of the open
application for which you want to add class information. Then, release the
mouse button.

The class name appears in the Class field (Figure 15.4).

4 Click OK to return to the Applications panel where you will now see the
class listed.
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Figure 15.4 Add Class Dialog Boxes (1)
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Disabling an nView Desktop Manager Function

To disable an nView Desktop Manager function, follow these steps:

1 From the Application panel, select the application or class for which you
want to disable a function.

Note: If the application or class for which you want to disable the function
does not appear in the list box, add it using the Add option.

2 Click the Disable, option to display the Disable nView Functions dialog box
(Figure 15.5).

Figure 15.5 Disable nView Desktop Manager Functions
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By default, all functions are enabled. You can chose to disable all functions
(Enable nView Desktop Management) or just a subset of functions from the
group of check boxes.

3 Click OK when you have finished selecting functions to disable.

Individual Settings

To set up individual application settings for an application, click Individual
Settings from the Applications panel.

Note: You can also set up individual application settings using the nView
options menu. To edit individual settings for an application, select
Individual Settings > Edit on an application’s nView option menu.

When you select to set up Individual Settings for an application, the
Individual Application Settings dialog box appears (Figure 15.6).
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Figure 15.6 Individual Application Settings
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From this dialog box, you can set up both individual window settings as well as
launch settings for the application.

The first box icon contains a “global” marker, which means that the application
uses the standard nView Desktop Manager settings for the feature. This marker
may be a check mark, solid colored square (as shown in the example in Figure
15.6) or other indicator, depending on the application.

The Allow transparency and draw at n% option is simply an on/off setting
that either enables or disables transparency for the application and sets an
individual transparency level to be used for the application during transparent
operations.

Launch Settings

Launch settings are only applied when an application is first started.

* The Transparency, Always on top, and Visible on all desktops can have
one of three settings:

On means the setting will always be turned on when the application starts.
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Off means the setting will always be turned off when the application
starts.

Last Setting means that when the application is closed, the setting will be
saved and then restored when the application is opened again. In other
words, the setting will be remembered.

* Restore window size and position, when checked, will cause nView
Desktop Manager to store the application window’s size and position when it
is closed and then restore the application to the same size and position when
opened again.

* Launch application on desktop lets you to set up a specific desktop to
launch the application on. You can select a specific desktop on which to
always launch the application from the drop down list. Two choices are
always listed: Active and Last.

If the Active desktop is chosen (default), the application will launch on
your currently active desktop regardless of the desktop you are on.

If the Last desktop is chosen, the desktop on which the application was
located when it was closed will be remembered and, when the application
is relaunched, it will open on that stored desktop (the last desktop it was
closed on).

Note: If an application is set to open up on a desktop different than your current
desktop, when you launch that application, you will be automatically
taken to the desktop on which the application launches.

Application Extensions

If you want to add Internet Explorer-specific and PowerPoint-specific
application extensions, click Application Extensions from the Applications
panel.

The Application Extensions dialog box appears (Figure 15.7).

Internet Explorer Options

Note: You must have Internet Explorer 6.0 (at minimum) installed on your
desktop to access the nView Desktop Manager-based Internet Explorer
options on the Application Extensions dialog box (Figure 15.7) explained
in this section.
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Figure 15.7 Application Extensions Dialog Box
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Add Microsoft Internet Explorer Double Right-click and Shift-
left-click Extensions

nView Options adds a new menu item called Open link on display » (Figure
15.8) on the Internet Explorer 6.0 browser, where n represents your display
device. For example, “1” is the only choice when only one display device is
attached; 1 and 2 are choices when two display devices are attached; 1, 2, and 3
are choices when three display devices are attached, and so on.

Note: Once you set this option on a primary Internet Explorer window, as
shown in the example in Figure 15.8, when you Shift-Left click or
double right-click any link from this primary window, the browser
window for that link opens on the display device you selected with the
“Open link on monitor” option.
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Figure 15.8 Internet Explorer Extensions
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Add Microsoft Internet Explorer Popup Preventer Extensions

nView Options adds a new menu item called Internet Explorer popup
prevention (Figure 15.9).

If you want to set the Internet Explorer popup preventer extensions for the
current instance of your Internet Explorer window, follow these steps:

1 Enable the Internet Explorer popup preventer extension options on the
Applications Extensions dialog box (Figure 15.7).

These settings will now apply to any session of Internet Explorer on your
desktop.

2 Ifyou want to apply settings to the current session of Internet Explorer while
the window remains open, follow these steps:

From the Internet Explorer window, click the title bar to access the nView
options menu. (nView options must be enabled to do this.)

Click Internet Explorer popup prevention and click Enable to check
(enable) this option (Figure 15.9).

Again, from the Internet Explorer window, click the title bar to access the
nView options menu. (nView options must be enabled to do this.)

Click Internet Explorer popup prevention and click Edit to open the
Internet Popup Window dialog box.

Enable the settings you want and click Apply.
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Figure 15.9 Internet Explorer Popup Preventer
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Add Microsoft PowerPoint Slide Show Extension

When you enable this option on the Application Extensions Dialog Box, the
nView Desktop Manager options menu adds a new menu item “Show slide
show on display »” on Microsoft PowerPoint 2000 and PowerPoint 2002,
where n represents the display device.

Note: Once you select a display on which to show slides, future slide shows
started from Microsoft PowerPoint will be shown on that display.
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